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Micro Focus Enterprise Server 2.3 Release
Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Note: This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link. Web
sites by their nature can change very rapidly and although we try to keep our links up-to-date, we
cannot guarantee that they will always work as expected.

Enterprise Developer Variants and Deploying Applications

Enterprise Server provides the execution environment for applications created with any IDE variant of
Enterprise Developer.

Note:

• Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro
Focus Infocenter for any updates to the documentation which might have been uploaded.

• This product includes OpenSSL version 1.0.1m.
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Installation

Installing on Windows

System Requirements for Enterprise Server for
Windows

Hardware Requirements
The disk space requirements are approximately:

Enterprise Server Sentinel RMS License Manager

1.2Gb 75MB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

Operating Systems Supported
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Note: This product can be installed on earlier versions of Windows but it has not been tested on
them.

Software Requirements
Note: The setup file will check your machine for whether the prerequisite software is installed and will
install any missing prerequisites and the product components.

Before installing this product, you must have the following software installed on your computer:

• The Microsoft .NET Framework - the setup file installs the .NET Framework 4.5.2 . You might need to
install the following version of the .NET framework manually, if it is targeted by your applications:

• Microsoft .NET Framework 2 - if your applications use the ILCLR(2) Compiler Directive or if they
target the .NET Framework versions 2, 3 or 3.5. You might need to download these installers
depending on the .NET Framework you are targeting.

To download the Microsoft .NET Framework 2 click here.

Microsoft .NET Framework 2 or later is also required for the Micro Focus License Manager if you
install this on a separate machine as a license server.

Note:

• .NET Framework 3 is provided with Windows Vista and Windows Server 2008.
• .NET Framework 3.5 is provided with Windows 7 and Windows Server 2008 R2.
• .NET Framework 4.0 is provided with Windows 7 and Windows Server 2008 R2.
• .NET Framework 4.5 is provided with Windows 8 and Windows Server 2012.
• .NET Framework 4.5.1 is provided with Windows 8.1 and Windows Server 2012 R2.
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• Microsoft's Web Platform Installer 2.0 if your application targets ASP.NET 4. This installs and sets up
ASP.NET. To download the installer click here.

• A Web browser is required for Enterprise Server Administration in Enterprise Server.

To use your Web browser offline, you need the dial-up networking feature of Windows installed.
Otherwise you might have TCP/IP errors such as being unable find "localhost" or the numeric equivalent
(127.0.0.1).

• To use Enterprise Server Administration, scripting or JavaScript support must be enabled in your
browser. This is on by default in Internet Explorer in most Windows operating systems. Also, active
content must be allowed and not blocked. To enable both these in Internet Explorer:

1. Click Tools > Internet Options.
2. On the Security tab, click Custom Level. In the Scripting section, under Active Scripting, click

Enable.
3. On the Advanced tab, scroll down the list to the Security section, and ensure the item Allow active

content to run in files on My Computer is checked.
• Enterprise Server Help requires the Java Runtime Environment on some Windows systems to enable

the Search facility to work.

Important: This release requires version 10000.2.990 or later of the Micro Focus License
Administration tool. For local servers, you do not need to install it separately, as the setup file installs
a new Enterprise Developer client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements on Windows
To ensure full functionality for some Enterprise Server features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the
Enterprise Server setup file. The following information specifies the third-party software required for each
feature.

• Application server support for JVM COBOL on page 6
• Application server JCA support for Enterprise Server
• Database Access on page 7
• Mainframe Access - Endevor Support
• WebSphere MQ on page 7

Application server support for JVM COBOL

Back to Top

The following application servers are supported using the following JDKs:

Application Servers JDK version Containers support version

Tomcat 7.0.39 1.7 Servlets 2.5

JBoss 7.1.1 1.7 Servlets 2.5

WebLogic 12.1.1 1.7 Servlets 2.5
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Application Servers JDK version Containers support version

WebSphere 8.5 1.7 Servlets 2.5

You need Oracle's JDK. The earliest supported release of Oracle's JDK 1.7 is 1.7.027. You can download
Oracle's JDK from Oracle's Web site.

Application server JCA support for Enterprise Server

Back to Top

Java EE 5 and Java EE 6 are supported for the deployment of EJBs generated using the Interface Mapping
Toolkit, as follows:

• Java EE 5 includes support for EJB 3.0 and Java Connector Architecture 1.5
• Java EE 6 includes support for EJB 3.1 and Java Connector Architecture 1.6

The following Java application servers are supported using the following JDKs:

Application Servers JDK (vendor) Java EE COBOL RA CICS RA

JBoss 5.1.0 1.6 (Oracle) 5 X

JBoss 6.1.0 1.6 (Oracle) 6 X

JBoss 7.1.1 1.7 (Oracle) 6 X X

Oracle WebLogic
10.3.5

1.6 (Oracle) 5 X

Oracle WebLogic
12.1.1

1.6/1.7 (Oracle) 6 X

IBM WebSphere 7.0 1.5 (IBM) 5 X

IBM WebSphere 8.0 1.6 (IBM) 6 X

IBM WebSphere 8.5 1.6/1.7 (IBM) 6 X X

Database Access

Back to Top

Before you can use Enterprise Server to deploy SQL applications developed with OpenESQL, DB2 ECM,
or COBSQL, ensure any third-party software prerequisites are installed and the environment is set
properly. Refer to the product help for Enterprise Developer, Welcome > Product Information > Installing
> System Requirements > Additional Software Requirements > Database Access, for details.

Mainframe Access - Endevor Support

Back to Top

• To use the Mainframe Access support for Endevor you must be using Endevor R14 or later. CA
stabilized the Endevor API at R14, so if you upgrade from R14 to a later version you will not need to
update the support module that Mainframe Access uses.

WebSphere MQ

Back to Top

IBM WebSphere MQ version 7 and later.

Installation Restrictions and Requirements
Before starting the installation, you should consider the following:
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• You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

• Before installing this product, make sure that any existing Micro Focus Directory Server (MFDS) or
CCITCP2 Windows service (on Windows) or a process (on UNIX) from an existing product is stopped
and uninstalled. On Windows, do this as follows:

1. Stop the MFDS and CCITCP2, using either the Windows Service Management Console GUI
(services.msc) or from a command line prompt by typing:

net stop mf_ccitcp2

Only one instance of the MFDS or CCITCP2 service can run on a Windows machine.
2. Uninstall the MFDS or CCITCP2 service.

For MFDS, from a command line prompt enter: mfds -u

For CCITCP2: ccitcp2 -u

To run an earlier version of MFDS as a service after you have installed a later version:

1. Stop and uninstall the MFDS service, as described above.
2. Reinstall the earlier version, as follows:

a. Open an  Enterprise Server command prompt.
b. Install the service. Enter the following command: mfds -i
c. Start the service. Enter the following command: net start mf_ccitcp2

Note: The two versions use different paths for environment and registry values, so the list of
configured enterprise servers might be different depending on which version has been started,
since, by default, different MFDS data repositories are used.

MFDS 5.1 and later are able to import or use Enterprise Server configuration data generated by earlier
versions of MFDS, but 5.0 or earlier versions of MFDS might not be able to read data generated by later
versions.

It is possible to run MFDS from a command prompt ("mfds") rather than as a service, but by default the
"mfcobol" port is used (86) and this can only be used by one process at a time

Installing Enterprise Server for Windows

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

Product Co-Existence
• Enterprise Server and Enterprise Test Server cannot coexist on the same machine.

Installing as an Upgrade
Before installing, check Installation Restrictions and Requirements.

• This release will not upgrade previous versions of the product. Any previous releases and HotFixes of
the product installed on your machine must be uninstalled before installing 2.3.

• Before installing this release as an upgrade, ensure you create a back-up of your Enterprise Server
configuration. To do this, on the Enterprise Server Administration home page, click Export and then
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select Export Enterprise Server configuration and Security Manager definitions. This creates a
backup folder in the c:\programdata\micro focus\Enterprise Developer\MFDS. You can
restore the Enterprise Server configuration after installing this release - click Import on the Enterprise
Server Administration home page.

Installing
Note: See Installing as an Upgrade first for important information, if you have an earlier version of
Enterprise Server installed on your machine.

These are the steps to install this product:

1. Run the es_23.exe file and follow the wizard instructions to install the prerequisite software and the
product.

The setup file will also install any missing prerequisite software as listed in the topic Software
Requirements.

Note:

• If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Program and Features
(Windows Vista or later), and rerun the installation file.

• Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.

• We recommend that you install any updates for the .NET Framework that are available at the 
Microsoft Download site.

• If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with Enterprise Server but you can install it if you wish.

Enterprise Server Installation Options
To install Enterprise Server you run es_23.exe which contains a number of product .msi files (Windows
Installer packages). When run, es_23.exe performs some initial system checks then sequentially installs
the .msi files.

es_23.exe can take a number of parameters, enabling you to specify a number of different types of
installation:

• Standard Installation

Format:
es_23.exe

Summary:
Full installation including License Manager and Enterprise Server. During installation you can specify
options including the location to which the components are installed.

• Non-interactive Installation

Format:
es_23.exe /passive

Summary:
Full installation, but the components are installed non-interactively using default options and
directories.

• Silent Installation
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Format:
es_23.exe /q

Summary:
Full installation, but the components are installed non-interactively with no user interface, using
default options and directories.

• Modified Silent Installation

Format:
es_23.exe /q InstallFolder=d:\cobolrts

Summary:
Full installation, but the components are installed non-interactively with no user interface, and
Enterprise Server is installed to d:\cobolrts.

To see what parameters you can use, execute the following from the command line: es_23.exe /?.

Note:

• Log files that are created during installation are saved in the folder specified by the TEMP
environment variable. To change the location or name of the files, use the /log parameter on your
setup command line and specify the path and file name, for example: filename /log d:\temp
\log.txt. This creates a log file, named log.txt, in the d:\temp directory.

After Installing
To access the Enterprise Server help:

• On versions of Windows 7 and earlier, select Start > All Programs > Micro Focus Enterprise Server
> Documentation from the Windows Taskbar.

• On Windows 8, right-click at the bottom of the Start screen, and click All apps to display all available
links for this product. In the Enterprise Server section, click Documentation.

This opens the online Micro Focus Infocenter in a browser. From the left-hand pane, select Enterprise >
Micro Focus Enterprise Server.

Note:

For applications created with earlier Micro Focus products or earlier versions of Enterprise Developer,
note the following:

Database
Access

Managed applications using SQL(DBMAN=ODBC) that were compiled in
Enterprise Developer 2.1 Update 1 must be recompiled in Enterprise Developer
2.3.

Existing
Applications

Application executables that were compiled using earlier Micro Focus products
must be recompiled from the sources using Enterprise Developer. For more
information, read the section Upgrading to Enterprise Developer for Visual Studio
2010 in the product Help.

Open PL/I
Compiler

Important: If you are installing this release as an upgrade to Enterprise
Developer 2.2 Update 1, after the upgrade you must rebuild any applications that
are compiled using the –zp1 option.

The behavior of the –zp1 option has been reverted to that of versions of Enterprise
Developer earlier than 2.2 Update 1, with an additional correction relating to Char
Varying data items.

The behavior has been restored to that in Enterprise Developer versions earlier than
2.2 where, when compiling with –zp1, all parameters are treated as unaligned. (In
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Enterprise Developer 2.2 Update 1, the behavior when compiling with –zp1 was to not
treat parameters as if unaligned).

When using the –zp1 compiler option, all Character Varying data items are now treated
as if unaligned. In previous versions of Open PL/I, for Character Varying data items,
the –zp1 unaligned requirement was applied only to structure members and
parameters.

To illustrate the change, consider the following example:

zptest: proc options(main); 
 
   dcl 1 st1, 
     2 c char, 
     2 x(4) char(7) var init ('a', 'xx', 'yyy', 'zzzz'); 
 
   dcl y(4) char(7) var init ('a', 'xx', 'yyy', 'zzzz'); 
 
   dcl sub entry ((4) char(7) var); 
 
   call sub (x); 
 
   call sub (y); 
 
end; 
 
sub: proc (z); 
 
   dcl z(4) char(7) var; 
 
   dcl i fixed bin(31); 
 
  do i = 1 to hbound(z); 
      z(i)  = 'x'; 
  end; 
 
end; 

Where:

• For x and z, each char (7) var item is 7 plus 2 bytes which equals 9 and then
multiplied by 4 equals 36.

• If y were aligned on half-word by default, each array element is half-word aligned
and each equals 10 bytes (9 + 1 pad byte), and the total size equals 40 bytes.

• At call sub (x), the calling argument and parameter are matched.
• At the call sub (y), the y element size (10 bytes) is mismatched against the

parameter z element size (9 bytes) due to –zp1. This is incorrect and causes
unexpected program behavior.

Due to this correction of treating all Char Varying data items as if unaligned when using
–zp1, the size of CHAR VARYING arrays now differs from previous versions of Open-
PL/I. For example:

   dcl X(4) char(7) var; 
 
   Put skip list (size(X))  /* size is 36 bytes vs. 40 bytes in 
previous versions of Open-PL1 */ 

Repairing
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.
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To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

Uninstalling
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.

When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.

Important: The installer creates separate installations for Micro Focus Enterprise Server and Micro
Focus License Administration. Uninstalling only Enterprise Server does not automatically uninstall the
Micro Focus License Administration or any of the prerequisite software.

To completely remove the product you must uninstall the Micro Focus License Administration as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:

start /wait install-file.exe /quiet /uninstall

Installing on UNIX

System Requirements for Enterprise Server for UNIX

Hardware Requirements for Enterprise Server
The disk space requirements are approximately:

Platform Installer type Setup

file size

(MB)

Disk space

required for

the installation

(GB)

Disk space

required for

running

the product

(MB)

Sentinel RMS

license
server

(MB)

POWER
running AIX

Micro Focus installer 479 1.91 GB 958 36.5

HP IA Micro Focus installer 782 3.13 GB 1564 69

System Z
running Red
Hat Linux

Micro Focus installer 324 1.29 GB 648 36

x86-64
running Red
Hat Linux

Micro Focus installer 338 1.35 GB 676 46
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Platform Installer type Setup

file size

(MB)

Disk space

required for

the installation

(GB)

Disk space

required for

running

the product

(MB)

Sentinel RMS

license
server

(MB)

SPARC
running
Solaris

Micro Focus installer 386 1.54 GB 772 40

x86-64
running
Solaris

Micro Focus installer 351 1.40 GB 702 31

System Z
running SUSE
SLES

Micro Focus installer 328 1.31 GB 656 36

x86-64
running SUSE
SLES

Micro Focus installer 344 1.38 GB 688 46

Operating Systems Supported
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Software Requirements
Before installing this product, you must have the following software installed on your computer:

• The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax --
version at the command line.

• On Red Hat 6.x and Red Hat 7, you must have the following operating system libraries installed:

glibc-*.x86_64
glibc-*.i686
libgcc-*.x86_64
libgcc-*.i686
libstdc++-*.x86_64
libstdc++-*.i686

• On IBM System z (390), you must have the following operating system libraries installed:

glibc-*.s390
glibc-*.s390x
libgcc-*.s390
libgcc-*.s390x

Visit the Red Hat Web site for more information.
• On SUSE and Red Hat, PL/I support requires that you have the following operating system libraries

installed:

libelf-devel-0.137-8.19
libelf1-0.137-8.19
libelf1-32bit-0.137-8.19
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• Oracle's Java Platform, Enterprise Edition (Java EE) 7 or Java 8 is required to execute COBOL JVM
code and for native COBOL and Java interoperability. The setup file installs Java 8 u51 32-bit. You can
download Oracle's Java EE from Oracle's Web site and install it anywhere on your machine.

Note:

• On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK
is 7.0 Service Refresh 8. You can get IBM's AIX JDK from IBM's Web site.

• On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX is JDK
7.0.11. You can get the HP-UX Java JDK from HP's Web site.

Before you start the installation, you need to set the environment as follows:

• You need to set the LANG environment variable to pick up localized messages. The LANG settings are
English and Japanese only.

• The Java Development Kit (JDK) is required for compiling Java. The JDK is downloadable from 
www.oracle.com. After installing the JDK, you must put the tools.jar file for the JDK on your classpath,
using a command similar to:

 set classpath=jdk-install-directory\lib\tools.jar

• JavaScript or scripting support must be enabled in your browser, so that Enterprise Server
Administration is usable. Also, active content must be allowed and not blocked.

Important: This release requires version 10000.2.990 or later of the Micro Focus License
Administration tool. For local servers, you do not need to install it separately, as the setup file installs
a new Enterprise Developer client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements on Linux and UNIX
To ensure full functionality for some Enterprise Server features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the
Enterprise Server setup file. The following information specifies the third-party software required for each
feature.

• Application server support for JVM COBOL on page 14
• Application server support for interaction with Enterprise Server on page 15
• Database Access on page 16
• Java Beans on page 16
• Java Development Kit (JDK) on page 16

Application server support for JVM COBOL

Back to Top

The following application servers are supported using the following JDKs:

Application Servers JDK version Containers support version

Tomcat 7.0.39 1.7 Servlets 2.5

JBoss 6.1 1.7 Servlets 2.5
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Application Servers JDK version Containers support version

WebLogic 12.1.1 1.7 Servlets 2.5

WebLogic 12.1.1 on AIX 6.1 1.7 Release 1 Servlets 2.5

WebSphere 8.5 1.7 Servlets 2.5

WebSphere 8.5 on AIX 6.1 1.7 Release 1 Servlets 2.5

Note:

• On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK 1.7
is 7.0 Service Refresh 8. You can get IBM's AIX JDK from IBM's Web site.

• On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX JDL 1.7 is
Java 7.0.11. You can get the HP-UX Java JDK from HP's Web site.

• On all other platforms, you need Oracle's JDK. The earliest supported release of Oracle's JDK 1.7
is 1.7.027. You can download Oracle's JDK from Oracle's Web site.

Application server support for interaction with Enterprise Server

Back to Top

Java EE 5 and Java EE 6 are supported for the deployment of EJBs generated using the Interface Mapping
Toolkit, as follows:

• Java EE 5 includes support for EJB 3.0 and Java Connector Architecture 1.5
• Java EE 6 includes support for EJB 3.1 and Java Connector Architecture 1.6

The following Java application servers are supported using the following JDKs:

Application Servers JDK (vendor) Java EE

JBoss 5 1.5/1.6 (Oracle) 5

JBoss 6 1.6 (Oracle) 6

Oracle WebLogic 10 1.5 (Oracle) 5

Oracle WebLogic 12 1.6/1.7 (Oracle) 6

IBM WebSphere 7.0 1.5 (IBM) 5

IBM WebSphere 8.0 1.6 (IBM) 6

IBM WebSphere 8.5 1.6/1.7 (IBM) 6

The availability of resource adapters for these Application Servers differs between UNIX platforms. The
following table indicates where support is available for each platform:

Feature/
Platform

JBoss 5 JBoss 6 Websphere
7.0

Websphere
8.0

Websphere
8.5

Weblogic 10 Weblogic 12

AIX 6.1 on
RS6000

32-bit 32-bit 32-bit 32-bit 32-bit 32-bit 32-bit

HP/UX 11.31
on Intel IA64

32- and 64-
bit

32- and 64-
bit

64-bit 64-bit 64-bit 32 and 64-bit 32 and 64-bit

Red Hat EL
6.2 on
IBM390

32-bit 32-bit 32-bit 32-bit 32-bit 32-bit 32-bit
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Feature/
Platform

JBoss 5 JBoss 6 Websphere
7.0

Websphere
8.0

Websphere
8.5

Weblogic 10 Weblogic 12

Red Hat EL
5.5 on AMD
Opteron

32-bit 32-bit 32-bit 32-bit 32-bit 32-bit 32-bit

Solaris 11 on
AMD
Opteron

32- and 64-
bit

32- and 64-
bit

32- and 64-
bit

32- and 64-
bit

Solaris 10 on
SPARC

32- and 64-
bit

32- and 64-
bit

32- and 64-
bit

32- and 64-
bit

SuSE SLES
11 SP1 on
IBM390

32- bit 32-bit 32-bit 32-bit 32-bit 32-bit 32-bit

SuSE SLES
11 on AMD
Opteron

32- bit 32-bit 32-bit 32-bit 32-bit 32-bit 32-bit

Eclipse IDE development is supported for Red Hat and Windows only.

Database Access

Back to Top

Before you can use Enterprise Server to deploy SQL applications developed with OpenESQL, DB2 ECM,
or COBSQL, ensure any third-party software prerequisites are installed and the environment is set
properly. For details, see the product help for the COBOL development system you used to develop your
applications, under Welcome > Product Information > Installing... > System Requirements... >
Additional Software Requirements > Database Access.

Java Beans

Back to Top

• Java Platform, Enterprise Edition (Java EE) 1.6 or later from Oracle or IBM. You can download the Java
EE from www.oracle.com.

Java Development Kit (JDK)

Back to Top

Compiling
Java

Either the IBM or the Oracle Java Development Kit (JDK), version 1.5 or later, is required
for compiling Java. The JDK is downloadable from the Oracle and IBM Web sites. After
installing the JDK, you must put the tools.jar file for the JDK on your classpath, using
a command similar to:

 set classpath=jdk-install-directory\lib\tools.jar

After installing the JDK, you need to set up your Java environment.

Installing Enterprise Server for UNIX

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.
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For more information follow the links for the installation instructions and the End User License
Agreement.

Installing on UNIX
Note: Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus
installer for installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for
installing on Linux. See your product Help for instructions on how to use the RPM installer.

These are the steps to install this product using the Micro Focus installer:

1. Give execute permissions to the setup file:

chmod +x setup_ent_server_2.3_platform

2. Run the installer with superuser permissions:

./setup_ent_server_2.3_platform

If you don't run this as superuser, you are prompted to enter the superuser password during the install.

If you set COBDIR to an already installed product, the installer will back up the existing installation and
will install this release in the location COBDIR points to. If COBDIR is not set, the installer does a fresh
install.

The COBOL run-time is installed by default into /opt/microfocus/EnterpriseDeveloper,
(COBDIR).

Note:

During the installation process, the installer configures the product's Enterprise Server System
Administrator Process User ID. The Process User ID will be the owner of all Enterprise Server
processes except the one for the Micro Focus Directory Server (MFDS). The Directory Server process
(Enterprise Server Administration) runs as root as this allows it to access the system files and ports.

All Enterprise Server processes you start from Enterprise Server Administration run under the
Process User ID which can affects the file access and creation.

By default, the installer uses the login id of the user that runs the installer for the Process User ID. To
change the user id after you complete the installation, execute $COBDIR/bin/casperm.sh.

SafeNet Sentinel considerations

• The installation of this product could affect the SafeNet Sentinel licensed components running on your
machine. During installation licensing is shutdown to allow files to be updated. To ensure the processes
running on your machine are not affected, you need to use the -skipsafenet option, which skips the
installation of SafeNet:

./setup_ent_server_2.3_platform -skipsafenet

• To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or shutdown the
running license daemons. If licensing needs to be updated later, remove the file and install Sentinel
RMS server manually.

After Installing
When you have installed the product, you need to set the environment as described below.

1. To set up your product, execute:

. /opt/microfocus/EnterpriseDeveloper/bin/cobsetenv

2. To verify that your product is installed, execute:

cob -V
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Important: These commands set the environment only for the current shell. You need to execute
them for each new shell that you start.

To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(such as etc/profile, etc/bashrc).

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Installing silently
You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.

You can use the following command line arguments to install silently on UNIX/Linux:

–silent -IacceptEULA

For example, execute:

[as root] setup_filename –silent -IacceptEULA

After the application is installed, you can silently install the license as follows:

• If you have access to the Internet and an authorization code, execute the following commands:

For 32-bit Windows environments:

start /wait "" "C:\Program Files\Common Files\SafeNet Sentinel\Sentinel RMS 
License Manager\WinNT\cesadmintool" -term activate AuthorizationCode

For 64-bit Windows environments:

start /wait "" "C:\Program Files (x86)\Common Files\SafeNet Sentinel
\Sentinel RMS License Manager\WinNT\cesadmintool" -term activate 
AuthorizationCode

• If you don't have access to the Internet but have a file from Micro Focus that contains the license string:

For 32-bit Windows environments:

start /wait "" "C:\Program Files\Common Files\SafeNet Sentinel\Sentinel RMS 
License Manager\WinNT\cesadmintool" -term install -f FileName

For 64-bit Windows environments:

start /wait "" "C:\Program Files (x86)\Common Files\SafeNet Sentinel
\Sentinel RMS License Manager\WinNT\cesadmintool" -term install -f FileName

where FileName is the name of the text file that contains all the license strings to be used.

UNIX and Linux Installer Issues

Installing on Linux

On Linux, the 32-bit version of Java is required to install and use Enterprise Developer for Eclipse. When
you start the installation, if the 64-bit version of Java is already installed on your Linux machine, you might
not be able to install Enterprise Developer. This is a known issue with the Oracle Java installers for Linux
which prevent you from installing both the 32-bit and the 64-bit versions of Java on the same machine. To
work around this problem:

• Download the 32-bit Java distribution in a compressed .tar format from the Oracle Web site.
• Untar the distribution into a location different from the one used for the 64-bit Java version. For example,

untar in /usr/local/java32 and not in /usr/local/java.
• Set JAVA_HOME and LD_LIBRARY_PATH to the 32-bit version of Java so that it is used to install and

run Enterprise Developer.
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License Infrastructure Installer

On some Solaris platforms, you can receive the following error message when SafeNet license server
needs to be installed or upgraded on your machine:

tar: /safenet.tar: No such file or directory

• To resolve this issue, wait for the installation to complete and then perform the following:

1. Navigate to the safenet directory in the COBDIR location.
2. With superuser permissions execute: ./MFLicenseServerInstall.sh

• Note: The following information applies when you are installing on Red Hat Enterprise Linux
(RHEL) 7.

Certain configuration changes in RHEL 7 (such as the /etc/inittab file no longer available) required
a change in the MF SafeNet license installer for this platform and the way you can manually manage the
licensing service.

By default, the MF SafeNet licensing service is still configured so that it starts automatically when
starting your machine. Only on RHEL 7, you must use the systemctl command available with the OS
if you need to override the default behaviour – for example, if you do not want run the MF SafeNet
licensing service at start-up or if you do not want the service to automatically start when you are
configuring trace levels.

1. Create a file, MFSafeNet.service, in /usr/lib/systemd/system/ with the following contents:

----------- start of /usr/lib/systemd/system/MFSafeNet.service -----------
    [Unit]
    Description=Micro Focus SafeNet licensing daemons. 
    Documentation=http://supportline.microfocus.com

    [Service]
    Type=forking
    ExecStart=/var/microfocuslicensing/bin/startboth.sh
    ExecStop=/var/microfocuslicensing/bin/stopboth.sh
    Restart=no

    [Install]
    WantedBy=multi-user.target
-----------  end of /usr/lib/systemd/system/MFSafeNet.service  -----------

2. Use the systemctl command to manage the SafeNet service:

[ asroot ] systemctl option MFSafeNet

Where some of the values that option can take are:

reenable Installs the SafeNet service.

is-enabled Checks the status of the SafeNet service. Does not require root privileges.

start Starts the SafeNet service.

stop Stops the SafeNet service.

restart Restarts the SafeNet service.

disable Disables the SafeNet service so it does not start when the machine is booted.

enable Enables the SafeNet Service so it starts when the machine is booted.

For more information about systemctl, refer to the help available with the RHEL OS.

License Server

You need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.
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The following is an example of how to specify these entries correctly in the etc/hosts file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Repairing
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Uninstalling
Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstall_EnterpriseServer2.3.sh script in the $COBDIR/bin directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
Note:

• If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.

• Your entitlement for using this product is governed by the Micro Focus End User License
Agreement and by your product order. If you are unsure of what your license entitlement is or if you
wish to purchase additional licenses, contact your sales representative or Micro Focus
SupportLine.

To buy and activate a full unlimited license
To buy a license for Enterprise Developer, contact your sales representative or Micro Focus SupportLine.

For instructions on using the Micro Focus Licensing Administration Tool, see Licensing in the Enterprise
Developer help.

To start Micro Focus License Administration

From the Windows Taskbar click Start > All Programs >Micro Focus License Manager > License
Administration.

Note: On Windows 8 and Windows Server 2012, you use the Start screen to invoke programs.

Log on as root, and from a command prompt type:

/var/microfocuslicensing/bin/cesadmintool.sh

Installing licenses

If you have a license file

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:

• Click Browse next to the License file field and select the license file (which has an extension
of .mflic).

• Drag and drop the license file from Windows Explorer to the License file field.
• Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file

into the box below the License file field.
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4. Click Install Licenses.

1. Start the Micro Focus License Administration tool and select the Manual License Installation option by
entering 4.

2. Enter the name and location of the license file.

If you have an authorization code

Authorizing your product when you have an Internet connection
Note: This topic only applies if you have an authorization code.

The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Type the authorization code in the Enter authorization code field.
4. Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.

1. Start Micro Focus License Administration.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter.

Authorizing your product when you don't have an Internet connection
Note: This topic only applies if you have an authorization code.

This method of authorization is required if your machine does not have an Internet connection or if normal
(automatic) authorization fails.

1. Start Micro Focus License Administration.
2. Click Manual Authorization on the Install page.
3. Make a note of the contents of the Machine ID field. You will need this later.
4. Do one of the following:

• If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.

• If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.
5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character

alphanumeric string supplied when you purchased your product.
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6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License

file field on the Install page.
10.Click Install Licenses.

In order to authorize your product you must have the following:

• Your authorization code (a 16-character alphanumeric string).
• The machine ID. To get this, start the Micro Focus License Administration tool and select the Get

Machine Id option by inputting 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.

1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.

2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.

3. Click Generate.
4. Copy the licenses strings from the web page or the email you receive into a file.
5. Put the license file onto your target machine.
6. Start the Micro Focus License Administration tool and select the Manual License Installation option by

inputting 4.
7. Enter the name and location of the license file.

To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for
Enterprise Developer, contact your sales representative or Micro Focus SupportLine.
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New Features in Enterprise Server 2.3
This release provides enhancements in the following areas:

• Database access
• Environment variables
• File handling
• iFileshare - Fileshare support under Enterprise Server (Technology Preview)
• Mainframe compatibility
• Micro Focus Infocenter
• RPM UNIX installer
• Spooler housekeeping
• Transaction class (TRANCLASS) support

Database access

Back to list

This release provides the following enhancements to database access:

HCO for DB2
LUW

This release provides:

• GUI versions of data migration tooling
• A new tool that enables you to bind or rebind all packages. See BindAll Packages Tool

for details.
• 64-bit support for PL/I on appropriate platforms. See Additional Software

Requirements on WindowsAdditional Software Requirements on UNIX for details.

HCO for SQL
Server

This release provides:

• Context Help is now provided for:

• Options for HCO for SQL Server tools
• Each tool in the HCO for SQL Server user interface

OpenESQL Date/Time
Processing

This release provides streamlined datetime processing for ODBC and
JDBC.

PL/I This version provides 64-bit support for PL/I on appropriate platforms.
See Additional Software Requirements on WindowsAdditional
Software Requirements on UNIX for details.

PostgreSQL In this release, PostgreSQL 9.4 has been tested with OpenESQL and
OpenESQL Assistant using the following PostgreSQL software:

Server software PostgreSQL EnterpriseDB version 9.4.4

Client software • psqlODBC driver version 09.03.04.00

PostgreSQL 9.4 has been tested with OpenESQL and OpenESQL
Assistant on the following Windows platforms:

• Windows 32-bit
• Windows 64-bit
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PostgreSQL 9.4 has been tested with OpenESQL on the following
UNIX platforms:

• X86-64 running Red Hat Linux, 32- and 64-bit
• X86-64 running SuSE Linux, 32- and 64-bit

Note: Micro Focus provides compatibility for PostgreSQL but
does not directly contribute to or support the PostgreSQL
open source project. Any issues relating to PostgreSQL
functionality should be addressed through an open source
support vendor.

Mainframe
Batch
Database
Tools (MBDT)

This release includes mainframe batch utilities that provide the following functionality for
Oracle, DB2 LUW, and SQL Server agnostically, as well as specifically for HCO for SQL
Server:

• DSNTEP2
• DSNUTILB LOAD
• DSNUTILB UNLOAD
• 32-bit and 64-bit support
• New batch configuration utility

XA Switch
Modules

In this release, the XA interface has been redesigned to provide:

• Consistent look and feel for SQL Server, DB2, and Oracle user personalization
• Consistent look and feel for both RM dynamic and static registration (SQL Server,

DB2, Oracle, generic one-phase commit for ODBC)
• Additional support for two instances of the same switch module using Web Services

applications via the new XAID compiler directive
• Using a specified XA resource only with batch applications executing under Enterprise

Server

Environment variables

Back to list

The following new environment variables are available:

MFJ_REPRO_EMPTY Enables or disables the ability for the IDCAMS REPRO action to copy
from a pristine VSAM file. Permissible values: Y or N.

ES_JESYSMSG_RESTRICTED When system message spool files are being routed directly to the
Output queue, by using ES_JESYSMSG_OUTPUT, you can hold back
spool files based on their class, by using
ES_JESYSMSG_RESTRICTED. Permissible values: class names or
numbers entered as a continuous string; for example,
ES_JESYSMSG_RESTRICTED=ABC123.

File handling

Back to list

This release contains the following new configuration options:

ACUFH Enables or disables the use of the ACU file handler (ACUFH), which is required to handle
Vision and RM/COBOL indexed files.
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ESACUFH Enables or disables the use of the ACU file handler (ACUFH) for file handling operations
running under Enterprise Server. ACUFH must also be enabled for this option to take effect.

iFileshare - Fileshare support under Enterprise Server (Technology Preview)

Back to list

Note: This is a technology preview feature only. It is being made available to allow you to test and
provide feedback on this new capability; however, this feature is not intended for production use and it
is not supported as such. Furthermore, Micro Focus does not guarantee that this feature will be
delivered at a GA level and if it is, then the functionality provided might differ considerably from this
technology preview.

Should you wish to test and provide feedback for this feature please contact Micro Focus Support Line
for instructions on how to enable the new functionality.

You can configure iFileshare to offer enhanced availability for mission critical files by configuring a high
availability group, consisting of a primary iFileshare server and a number of stand-by servers. (Currently,
this type of configuration only supports having one stand-by server)

Files that are critical to your application can be replicated from a primary server onto the stand-by servers.
Should the primary server fail, you have up-to-date data (minus any in-flight transactions) available.

To reduce the complexity and to increase the stability of an iFileshare high availability group, it is
recommended that each region is configured as a dedicated iFileshare server. If other Enterprise Server
work is hosted within the group, the setup must be consistent on each server so that in the event of a fail-
over, the non-Fileshare work can be continued on the new primary server.

Mainframe compatibility

Back to list

• IMS DBCS - Enterprise Server IMS support has been expanded to include applications that use double-
byte character sets (DBCS). MFS EATTR=ECGS (full DBCS string without SOSI) is now supported.

• Implement /DIS USER DEQUEUE - the /DEQUEUE USER command is now available to remove
messages from the message queue to provide you with greater flexibility when managing IMS systems.

• IMS message queue (available with the 2.3 HotFix1 update) - provides a new dynamic IMS message
queue that enables you to expand the queue on the fly, and also to fine-tune its performance
dynamically.

Micro Focus Infocenter

Back to list

The Micro Focus Infocenter Web site (http://documentation.microfocus.com) has been upgraded and now
includes the following improvements:

• Scope being persisted when you select a product documentation in the Product Documentation section
on the Micro Focus SupportLine Web site and choose to view the documentation in the Micro Focus
Infocenter.

• Updated Scope settings - provides the ability to nest four levels deep when setting a scope.
• Scope being persisted between browser sessions once it has been set.
• Creating automatic scopes using the Search Topics icon, .
• A link to change the scope from the search results when there are too many results.
• Improved Boolean search expressions.
• Details included with the search results.
• Help on how to use the Infocenter and how to construct search expressions - available using the

Infocenter Help button, .
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RPM UNIX installer

Back to list

In addition to its proprietary installer for installing Enterprise Server on UNIX and Linux, Micro Focus
provides a standard RPM installer for installing Enterprise Server on Linux. RPM Package Manager (RPM)
is a technology available on all Linux operating systems for managing the installation of products.

The RPM installer for Enterprise Server supports all the RPM functionality.

For instructions on how to install using the RPM installer, refer to the Installation section in your product
help.

Spooler housekeeping

Back to list

A new spooler housekeeping utility has been introduced (MVSSPLHK). It offers additional archiving
functionality compared to the previous spooler housekeeping utility (MVSP0027), and can also be
configured to run directly from a JCL job.

Transaction class (TRANCLASS) support

Back to list

Transaction class (TRANCLASS) support is no longer a technology preview feature, and is now a full
release feature.
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Known Issues
Refer to the Known Errors and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

Debugging

Remote debugging does not work for programs running on AIX or HP machines, if you are trying to debug
using Enterprise Developer installed on a Linux machine.

Enterprise Server

• The Historical Statistics Facility may generate incorrect records for SSTM-enabled enterprise servers.
• On Windows 10, if you are using Microsoft's EDGE browser to access the Enterprise Server

Administration GUI, issues with EDGE can cause the automatic refresh feature to display a dialog
asking whether you want to resubmit a form. To work around this issue, cancel the resubmit request and
then refresh the server list page or the Home page of Enterprise Server Administration. You can also
turn off the automatic refresh by setting the Auto-refresh interval setting on the Home page of
Enterprise Server Administration to 0.

• Enterprise Server instances will fail to start if they have been configured with the MLDAP ESM module
to use external security and are started using Enterprise Server credentials that are not configured with
"user administration" privileges (that is they do not have an allow update ACE in the "User
Administration" security resource in the Enterprise Server Administration). A fix for this is available if you
install HotFix 1 of version 2.3. of this product.

ICETOOL Emulation

ICETOOL emulation for managed code is not available in this release.

Linking

Changes in the C compiler in Visual Studio 2015 affect the way you link COBOL object code and C object
code built with that version of Visual Studio in the same executable. In this scenario, you must use the
Microsoft link utility and the C runtime libraries directly from Visual Studio, rather than the Micro Focus
cbllink utility, the Microsoft link utility and the libraries supplied with Visual COBOL. You might also need to
specify some additional C runtime libraries - see the Microsoft documentation for more details.

Note that when using COBOL and C object code together, Micro Focus recommends you build and keep
the COBOL and C executables separate, and use import libraries and the Micro Focus C functions for
calling COBOL (see "C functions for calling COBOL" in the product help) to resolve calls between them.

PL/I Support

• The Micro Focus PL/I Macro Preprocessor supports the majority of the IBM PP(MACRO) functions. The
only support for PP(PLX) is for the deprecated KEYS option. There are no plans to further extend the
existing support for PLX.

• On SUSE, the PL/I CodeWatch debugger does not display output with MicroFocus ViewNowX. To
resolve this issue, you need to install a HotFix of ViewNowX - contact Micro Focus SupportLine for more
details.

• Trying to debug remote PL/I projects that compile to 32-bit using the CodeWatch debugger fails. To work
around this issue, you must set the environment variable $COBMODE to COBMODE=32 on the remote
machine before you start the RDO daemon.
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Resource Adapters

Trying to deploy the local resource adaptor mfcobol-localtx.rar to WebLogic may fail with a
ClassCastException. To work around this issue, you need to deploy mfcobol-xa.rar first, then need to
undeploy this file and deploy the local one, mfcobol-localtx.rar. If there are issues deploying using
the WebLogic GUI, you can use the command line. If there are issues with this as well, try reducing the
length of the command (for example, by moving the file to a location with a shorter path).

Setup

• On UNIX, check UNIX Installer Issues before you start the installation.
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

Where present, the numbers that follow each issue are the Support Incident Numbers followed by the
Reported Problem Incident (RPI) number (in parentheses).

• Assembler Support
• CAS Security
• CAS XA Switch modules
• File Handling - External File Handler
• File Locking
• J2EE Connector
• JCL Support
• Mainframe Access
• MF Server Administrator (GUI)
• PL/I Support
• SQL - HCO for SQL Server
• Updated Run-Time System

Assembler Support

Back to the list

• Previously, the Assembler run-time error SOC4 (Invalid 370 address abend) was mapped to the COBOL
run-time error 200 (Internal logic error) which was misleading. It is now mapped to the COBOL run-time
error 205 (COBRT205 Invalid mainframe pointer value (Fatal)). Note that, in most cases, you receive an
Assembler SOC4 abend if the calling COBOL program was compiled without the AMODE(24) or the
AMODE(31) Compiler directives.

2806239 (1097738)

CAS Security

Back to the list

• The Enterprise Server External Security Facility now includes MLDAP ESM Module 2.0, with a new
algorithm for identifying the best-matching resource-access rule and ACE for resource-access security
checks. This algorithm is faster and matches most customers' expectations. The new algorithm also
provides an optional "username substitution" feature. It can be enabled by setting "rule substitutions" to
"yes" in the [Operation] section in the Security Manager configuration text area. When this is enabled,
the string "${user}" in a resource-rule name will be replaced with the name of the user that makes the
request. For example, a DATASET rule named "USERS.${user}.**" would apply to datasets with the
requesting user's name as the second qualifier. In rare cases, customers with complex, ambiguous
resource-access security rules might see experience changes in behavior as a result of the new
algorithm. The old algorithm is still supported and can be enabled by setting "version 1 authentication"
to "yes" in the [Operation] section of the Security Manager configuration.

2807531 (1097783)

CAS XA Switch modules

Back to the list
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• The XA switch modules now support dynamic registration.

2682101 (1092325)
• The XA switch modules now support batch-only operations when multiple XA Resource Managers have

been defined.

2664675 (1091082)
• In Enterprise Developer 2.2 update 2, Micro Focus identified undefined run-time behavior when the

following combination of directives was specified: SIGN"EBCDIC", CHARSET"ASCII", and one of the
following: HOST-NUMMOVE, HOST-NUMCOMPARE or SIGN-FIXUP. Previously (Enterprise Developer
2.2 update 1 and earlier), if this combination was specified, the SIGN”EBCDIC” directive should have
been ignored, to avoid a mixture of ASCII and EBCDIC characters; however, SIGN”EBCDIC” was still
being honored, resulting in undefined run-time behavior. Therefore, this combination of directives is now
invalid for Enterprise Developer 2.2 update 2 or later, and if specified, will be rejected at compile time.

2786397 (1095265)

File Handling - External File Handler

Back to the list

• Custom file handlers (using DYNREDIR) are now called for each part of a concatenated file.

2795077 (1096322)

File Locking

Back to the list

• In versions prior to Enterprise Developer 2.3, the semantics of the sharing phrase specified in an OPEN
statement or used within a call to CBL_OPEN_FILE were not correctly applied in some cases on UNIX
and Linux platforms. From version 2.3 onwards, the sharing phrase is correctly honored when the
tunable strict_file_locking=true is set, which is the default setting.

Example of potential changes in behavior:

• Process-A opens a file with read-only access and a sharing mode that denies other processes write
access (SHARING WITH READ ONLY).

• Process-B then attempts to open the file with read-only access and a sharing mode that denies
other processes read access (SHARING WITH NO OTHER).

With strict_file_locking=true, Process-B is unable to open the file, because Process-A has
successfully opened the file allowing only read access.

With strict_file_locking=false, Process-B successfully opens the file.

If your application encounters unexpected OPEN conditions or fails to open files, it might be as a result
of the new file locking behavior. In such circumstances, we recommend that you review the file locking
and sharing requirements of your application and refactor your source code to work with the default
setting. The original file locking and sharing behavior can be restored by setting
strict_file_locking=false.

J2EE Connector

Back to the list

• This release provides a new command-line argument to Java, mf.ssl.algorithm, which can be set to an
appropriate algorithm.

2799213 (1096684)

JCL Support

Back to the list
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• When allocating a dataset to a step using MVSCTLBP, the values returned for the dataset attributes are
those defined in the catalog. If these are unset in the catalog, then the values defined in the
MVSCTLBP call are returned.

2816179 (1098882)
• The program attributes for the SSTM job have been changed to default to a mainframe dialect, AMODE

31 program. These attributes will be used when constructing the MVS Control Blocks for the job, which
means that the pointers to the sub-block areas will be in mainframe format rather than native format.

2815695 (1098825)
• Any OUTPUT statement information passed to the printer exit now includes the correct class of that

statement.

2814249 (1098636)
• In ESMAC, when deleting the Spool, the physical spool files and the entries in casspool.dat are deleted.

2812899 (1098412)
• New functionality has been added to the printer exit interface that enables you to delete the printer spool

file after a file has been printed. Set (ws)-prn-file-disp, which is defined in cascbprn.cpy, to 1 to delete
the spool file after printing. Additionally, the environment variable ES_JESYSMSG_OUTPUT=Y now
correctly routes spool files to the Output queue. Previously, ESMAC still showed the job on the HELD
display, even when there were no spool files HELD.

2812899 (1099966)
• A new environment variable has been introduced - ES_JESYSMSG_RESTRICTED. JESYSMSG spool

files are normally routed to HELD. This can be overridden by setting the environment variable
ES_JESYSMSG_OUTPUT=Y, which causes all JESYSMSG spool files to be routed to OUTPUT. If
ES_JESYSMSG_OUTPUT=Y is set but you require specific classes to be held, set the environment
variable ES_JESYSMSG_RESTRICTED to a string containing the classes to be HELD.

2812878 (1098417)
• The IEBDG PICTURE value length must match the length specified. The value can now contain any

characters including quotes as on the mainframe.

2794881 (1096221)
• Changes to the IDCAMS ALTER processing prohibit applying MGMTCLASS changes to GDGs and to a

VSAM element other than a Cluster. Shareoption settings in a SMS DATACLASS are now applied to the
VSAM elements correctly.

2789939 (1095803)

JVM COBOL

Enterprise Developer for Eclipse now ships with Eclipse 4.4.2 (Luna). A consequence of this is that if your
application also contains JVM COBOL code that was built with a version of Enterprise Developer prior to
version 2.3, those parts of your application must be rebuilt; otherwise you will experience errors at either
compilation or run time.

Mainframe Access

Back to the list

Mainframe Access is now built using the IBM XL/C compiler rather than the SAS/C compiler that was used
previously. This change requires you to update your production JCL procedures with reference to the
supplied samples MFA, MFAS, and MFAAS. In each JCL procedure, change the STEPLIB DD statement
and add a new one, CEEOPTS.

The web administration feature is no longer available in Enterprise Developer.

To use the Mainframe Access support for Endevor you must be using Endevor R14 or later. CA stabilized
the Endevor API at R14, so if you upgrade from R14 to a later version you will not need to update the
support module that Mainframe Access uses.
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MF Server Administrator (GUI)

Back to the list

• Passwords that entered through either the MFDS or the ESMAC interface now use the same encoding.

2792382 (1096011)

PL/I Support

Back to the list

• For BASED variables declared using the form BASED (ADDR(x)), storage checking is now performed
on the base reference “x”. This behavior requires the compiler option –nolaxbased. See the Open-PLI
User guide for more information on the options –[no]laxbased and –[no]laxdefined.

2819663 (1099293)
• The behavior of the –zp1 option has been reverted to that of before Enterprise Developer 2.2 Update 1,

with an additional correction relating to Char Varying data items. For a full description of the –zp1
option, refer to the Open-PLI User’s Guide in your product help. If you are installing ED 2.2 U1 HF5 as
an upgrade to ED 2.2 U1, you must rebuild any applications that are compiled using the –zp1 option
after the upgrade.

2789213 (1095636)
• Previously, when using any of the complier options -mvs, -dli, -ims, or -cics, the BINARY attribute was

incorrectly applied if the FIXED attribute is specified without BINARY or DECIMAL. The default attribute
DECIMAL is now applied.

• The BIGENDIAN attribute, when explicitly applied to a structure, is now propagated to its CHAR
VARYING and WIDECHAR VARYING members.

• Declarations using DEFINED storage are now checked for compatible types between the DEFINED
variable and its base variable. This behavior requires the compiler option –nolaxdefined. See the Open-
PLI User guide for more information on the options –[no]laxbased and –[no]laxdefined.

• The PL/I Macro preprocessor has been enhanced to support the use of the ANSWER statement from
within a PL/I Macro.

2698537 (1094243)
• The macro preprocessor has been enhanced to support arrays of CHAR and FIXED variables. New

macro builtin functions have been implemented (HBOUND, LBOUND, DIMENSION).

2696129 (1094011)

SQL: HCO for SQL Server

Back to the list

• The return type for the HCOSS DB2 CHAR() function has changed from CHAR(255) to
VARCHAR(255).

2804069 (1097253)

Updated Run-Time System

Back to the list

• Enterprise Server now provides an execution environment capable of running applications that were
each built using different development products. A consequence of this is that if your application has a
main COBOL executable (.exe) that was built with a version of Enterprise Developer prior to version 2.3,
you should ensure that the executable is rebuilt and packaged with the new run-time system. This does
not affect mainframe subsystem projects deployed to Enterprise Server. You can rebuild from the IDE or
the command line.
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Other COBOL subprograms built with previous versions of Enterprise Developer are not required to be
rebuilt.
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Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• Adis
• CASRDO
• CICS Support
• Compiler
• Documentation
• ecijava
• Enterprise Server
• File Handling
• HCO for Microsoft SQL Server
• IBM Language Environment for OS/390 and VM Support
• IMS Support
• JCL Support
• Library
• Mainframe Access
• Micro Focus Common Client
• Micro Focus Communications Server
• Micro Focus Directory Server
• Micro Focus Server Administrator (GUI)
• MLDAP API Interface
• Monitoring and Management
• PL/I Support
• Run-Time System
• Setup
• SQL: COBSQL
• SQL: DB2 ECM
• SQL: HCO for SQL Server
• SQL: OpenESQL
• XML Extensions
• XML Support

Adis

Back to the list

• Paste now works as expected when pasting into numeric items under MS(2) with ACCEPT statements.

2800091 (1096820)
• When the MS Compiler directive is set, ACCEPT with EMPTY-CHECK now supports manually entering

of a zero for numeric items and a space for alphanumeric items.

2795831 (1096324)
• When using ACCEPT WITH UPDATE with the MS Compiler directive, the pre- and post- display

behavior is now the same as that of the MS compiler.

2795709 (1096311)
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CASRDO

Back to the list

• When trying to access the Catalog page from casrdo45, the JESSPOOL class was checked instead of
DATASET.

2819633 (1099350)
• The ESMAC Spool view is now sorted correctly when using a filter criteria.

2798643 (1096681)

CICS Support

Back to the list

• Compiling a BMS file that includes COPY statements and macros that contain comments no longer
shows an error in scenarios where the /PREPASM compiler directive is used to pre-process the BMS
file and no pre-processing errors were reported.

2791709 (1095975)

• Previously, if an EXEC CICS RECEIVE MAP was executed in a transaction that was started from an
EXEC CICS START TERMID, the RECEIVE would hang.

2811686 (1098238)
• TWA registrations no longer cause memory leaks.

2808391 (1097845)
• It is now possible to use an environment variable to configure the maximum number of pool threads of

threaded processes. This should only be used if requested by a Micro Focus SupportLine
representative.

2808391 (1097846)

• The CICS Web interface now supports http requests that are greater than 32k. Previously, a LINK to the
application would fail with errors EIBRESP 22 (LENGERR) or EIBRESP2 11 (The COMMAREA length
is less than 0 or greater than the permitted length). Note that a request in the commarea will be
truncated as is the behavior on the mainframe.

2833996 (1101078)
• Previously, an EXEC CICS INQUIRE TASK LIST statement with more than one option (RUNNING/

SUSPENDED/DISPATCHABLE) would return the information about the current task only, even if there
were other running or suspended tasks in the system.

2819519 (1099396)
• Executing the first EXEC CICS READ statement on a file defined as a remote one on the TOR and both

as a cataloged one and "open on first reference" on the FOR no longer fails.

2809423 (1097915)
• This release provides a new user exit, casmguex. You can use casmguex to control whether a particular

message is displayed on the console or not.

2808523 (1098090)
• The EXEC CICS FORMATTIME option MILLISECONDS is now supported. MILLISECONDS(data-area)

returns the number of milliseconds in the current second specified by ABSTIME as a binary integer in
the range 0 - 999.

2807604 (1097661)
• When a SIT commarea override is set, an XCTL with a commarea now passes the data correctly.

2804601 (1097349)
• The Micro Focus implementation of ECI was matching a shorter system-name than the one specified. Is

is now verifying the name on length of the server name passed to the ECI interface.
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2800359 (1096885)
• When using COMMAREA override, the exit of an XCTL command was not restoring the ptr for the next

COMMAREA to the original COMMAREA.

2793862 (1096334)

• When changing a class in ESMAC for a sysout, the MVSSPOOL class was not changed to reflect the
new class, and the old class was being passed to the exit. This has now been fixed.

2680710 (1092574)
• To ensure that the F1 Help function behaves correctly, the resource definition file must be upgraded

using the command: caspcupg /dp=<resource-definition-path>

2789687 (1096765)

Compiler

Back to the list

• A program compiled with the INIT-BY-TYPE directive that contains 'PROGRAM-ID IS INITIAL' syntax
and declarations of index names or data items now produces correct intermediate code.

2831469 (1100741)
• A redefinition of a CICS-inserted DFHCOMMAREA block that is preceded by a level 77 definition now

compiles correctly.

2831205 (1100706)
• Programs compiled with DIALECT"RM" and containing 'PROGRAM-ID .. AS' syntax now execute as

expected.

2830956 (1100700)
• The CP preprocessor used in conjunction with the COBSQL preprocessor now correctly replaces any

text affected by the COPY... REPLACING statement.

2826558 (1100370)
• When using the WINDOW1 preprocessor, specification of the AUTOCLOSE option no longer prevents

subsequent preprocessor options from being actioned.

2822206 (1099687)
• The output from the SETTINGS compiler directive now also appears for programs specified via the

ILSOURCE option.

2822102 (1099604)
• The XML GENERATE statement now functions as expected in programs containing the DECIMAL

POINT IS COMMA clause.

2821786 (1099599)
• The XML GENERATE statement now executes correctly when the specified FROM operand is a group

containing nested ODO tables (which is only possible with the ODOSLIDE directive).

2821779 (1099600)
• The INITBYTYPE compiler directive no longer causes spurious flag messages with DIALECT(OSVS).

2820920 (1099488)
• The LINE-COUNT Compiler directive now operates as expected.

2817442 (1098979)
• The maximum size of data items in a program compiled with the DIALECT(ENTCOBOL) directive now

correctly reflects the respective mainframe values in the latest version of Enterprise COBOL.

2816030 (1098926)
• The Compiler now rejects the use of special register names as arguments for reserved word altering

directives. You can only specify standard reserved words with these directives.

Resolved Issues | 37



2813931 (1098542)
• Data names that start with a numeric digit and contain DBCS characters are now accepted by the

Compiler, as expected.

2813223 (1098456)
• A MOVE operation of an alphanumeric literal to an unsigned numeric DISPLAY field under RM/COBOL

emulation now executes as expected.

2812561 (1098446)
• Data names longer than 30 characters are now flagged when specifying the FLAG option with a

mainframe argument and not just when using the equivalent full DIALECT.

2810924 (1098133)
• Compiling a program with the COBSQL preprocessor, which contains a COPY REPLACING statement

with trailing spaces in the replacement pseudo text, now works as expected.

2807470 (1097737)
• Compilation of a program containing a GO TO statement that references an undeclared procedure

name, and has the RESTRICT-GOTO directive set no longer results in a run-time exception.

2807280 (1097616)
• A user function that specifies a PIC 1 item as a RETURNING field now receives an appropriate compile-

time error.

2806037 (1097470)
• The addressability of a linkage data item is now checked correctly.

2805523 (1097453)
• Compilation with a mainframe dialect, of a program containing a CALL statement with a mixture of

non-01 level group items and literals, now proceeds as expected with no internal error produced.

2803613 (1097190)
• A debugger query of a condition name with a negative literal VALUE now returns the expected result.

2801993 (1097607)
• The combination of a mainframe dialect and SOURCEFORMAT(FREE) no longer produces unexpected

compiler errors referring to tokens being in the wrong area of source.

2800332 (1096911)
• The specification of an alphanumeric literal in the VALUE clause of a DBCS data item (i.e. the G\N

prefix is missing) is now accepted as an MF extension. This still generates an error under mainframe
dialects, but can be hidden/suppressed like any other flag message.

2798426 (1096574)
• Under DIALECT"MF", the Report Group description entry now permits the NEXT GROUP NEXT PAGE

clause without a LINE clause.

2798367 (1097201)
• It is now possible to specify fixed-point numeric literals without a trailing separator space before the next

token or operator. This provides a better mainframe emulation.

2797274 (1096469)
• A new CP option, ANYCOPYCASE, now provides more flexibility in matching the case of copybook

names.

2797035 (1096494)
• Previously, numeric items that used a decimal point and the OR sign were truncated when using the MS

display syntax under MS(2).

2795709 (1096308)
• DBSPACE(MIXED) directive has been implemented to allow comparison of mixed single and double-

byte spaces to the SPACE figurative constant.
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2679222 (1092427)
• When importing an Enterprise Developer source file, the generation of a CBLast (COBOL Abstract

Symbol Table) file no longer hangs when instructed to process a COBOL.DIR file.
• Mixing alphanumeric and national items in intrinsic functions which only allow one type now produces a

syntax error.
• A source line longer than the maximum supported by the compiler no longer receives an error about

truncation if the line is simply a comment.
• An error during compilation, when creating .int files when the COBDATA directive is set, has been fixed.
• An error reading the default directive file $COBDIR/etc/cobol.dir when COBDATA is set during

compilation has been fixed.

• A bug in accepting a field containing double-byte and single-byte characters has been fixed.

2829369 (1100513)
• A bug during compilation has been fixed, which caused a Run-Time System error 114 when generating

32-bit programs using the OPT directive, containing decimal operations.

2819838 (1099305)
• An error has been fixed in COMPUTE statements of the following form: COMPUTE a = b / constant

where a and b are COMP-3 or DISPLAY; a has greater than 19 digits and b has less than or equal to 19
digits, and constant is a literal which is a power of 10 (such as 10, 100, 1000, etc.)

2808008 (1097715)

• An error in managed COBOL that resulted in EXIT PROGRAM or GOBACK statements not being
executed has been fixed. The error could occur when perform ranges overlapped.

2825425 (1100162)
• When compiling for JVM COBOL with the ILSMARTLINKAGE directive, pic 9v9 items used as VALUE

parameters are now generated correctly.

2815477 (1098847)
• An illegal instruction 'invokespecial' is no longer generated. Previously, in some circumstances, this

could be generated, leading to a verification error on class load.

2811246 (1098205)
• When compiling a large program for JVM COBOL, the use of performtype(osvs) or performtype(rm) with

declaratives no longer leads to bad code generation and invalid jump errors when loading the resulting
class.

2695030 (1093952)

• Very large screen section records no longer produce unpredictable errors when generating managed
COBOL code.

2830002 (1100580)
• Programs that contain report-writer syntax, and are compiled with either PERFORMTYPE(RM) or

PERFORMTYPE(OSVS), now behave as expected.

2824931 (1099963)
• When forming externalised names for ILSMARTLINKAGE, any double-byte hyphen (or similar)

characters are now removed from the name.

2822491 (1099668)
• For class programs containing COBOL files declared in the OBJECT section, it is now possible to

explicitly add the program to a run unit. Previously, this would cause a run-time exception.

2819597 (1099273)
• The use of the SCREEN SECTION CONTROL phrase in .NET unverifiable code no longer causes the

generation of illegal code.

2818736 (1099170)
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• An INITIALIZE statement applied to a file record, which is not otherwise referenced, now correctly
initializes the whole record area.

2817756 (1099017)
• Verification or run time errors are no longer produced when NUMPROC(ACOS) is specified, and a level

88 item is declared for a numeric item in the Linkage section of your program.

2815137 (1098693)
• Opening a XAML file in a WCF client project no longer causes an unhandled exception to be generated.

2813004 (1098525)
• You can now use an external member reference as a target operand for the INITIALIZE statement. In

previous versions of the product, you could not.

2812151 (1098318)
• In previous versions of the product, compilation errors resulted when the NOILNATIVE directive was

specified when compiling programs that used the OCCURS ANY syntax for defining tables. This is no
longer the case, and the NOILNATIVE directive has no effect on such tables.

2809432 (1097893)
• The INITIALIZE statement is now working as expected when applied to a group item where an

OCCURS subgroup follows a FILLER data item. Previously, this could produce bad code, initializing
incorrect areas of the group.

2805149 (1097372)
• For class programs containing COBOL files declared in the OBJECT section, it is now possible to

explicitly add the program to a run unit. Previously, this would cause a run-time exception.

2802641 (1099053)
• When compiling for managed code (.NET or JVM), a zero length literal used as a value for a PIC N data

item no longer crashes compilation with run-time error 181.

2799176 (1096677)
• If a method has an optional parameter with a default value of System.Reflection.Missing.Value, and that

parameter was omitted in a method invocation expression, that parameter was being passed as null,
instead of the correct default value. This affected a number of methods - for example,
Microsoft.Office.Interop.Excel.

2796911 (1096408)
• Comparisons between PIC N or PIC G items and ALL hex-literals are now working correctly.

2795393 (1096266)
• Managed code that includes operands of the form 'typedef-name AT pointer' now generates correctly.

(607855)

Documentation

Back to the list

• The product help now includes the optional attributes for the ‘container’ objectclass definition used by
Enterprise Server external security.

2801420 (1096977)
• The product help now includes information about how to retrieve the Run-Time System error code from

a file status code returned as a decimal value. For example, if you receive 14657 as a value for the file
status, this is a decimal value. This converts to 3941 HEX. The second byte of this value, 41, must be
converted to Decimal before looking at the RTS error code - thus this HEX value then represents an
extended file status code of 9/065 which means the error code is COBRT065, a locked file status.

2822853 (1099769)
• The MFJSTATS topic has been updated to clarify that this refers to a COBOL SORT operation.
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2828881 (1100446)
• The product documentation about the START statement and Relation Conditions now states that THEN

may be used instead of THAN.

2799291 (1096903)
• The default setting for the ES_ESM_PLTPISEC variable is NONE.

2821810 (1099672)
• Additional information has been added to the description of the CASSI1400 error message.

2821806 (1099711)
• The AdminAPI resource class has been documented for ESF features.

2815870 (1098815)
• The Enterprise Server documentation for Retain Periods has been updated to include additional

information specific to spool output.

2790146 (1095777)
• The LISTCAT topic in the documentation has been updated to reflect accurate column headings and

descriptions for output format.

2789939 (1095765)
• The explanation of error message CASCF0052S has been updated with UNIX-specific information.

2821745 (1099737)
• Topic amended to refer to entry_point_mapper rather than entry_name_mapper.

2807744 (1097673)
• Details on MF_MVSJOB environment variable added.

2797526 (1096488)
• The Micro Focus Communications Server now supports rotational log files. To enable this feature, you

need to edit the mf-server.dat file, which resides in the product's bin directory (Windows), or the
$COBDIR/etc directory (UNIX). The mf-server.dat file contains details of this feature under the [logging]
paragraph, and full documentation is provided in the online help under "Server Instance Diagnostics:
CS Console".

2675327 (1092083)
• NONCONNECTED has been added to the list of attributes of DECLARE.

ecijava

Back to the list

• Stateless Java ECI requests no longer cause memory leaks in MFCS as a result of abandoned
sessions.

2822108 (1099645)
• The Enterprise Developer product help now includes information about the CICS Resource Adapters

and ECI.

2799936 (1096775)

Enterprise Server

Back to the list

• When using an EXCI link and a PPT defined with commarea 32767, the modified commarea was not
reflected back to the caller.

2830739 (1100654)
• It is possible to configure a Visual Studio or an Eclipse project to perform emergency debugging of an

application running in an enterprise server even when the server is operating in production mode (with
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dynamic debugging disabled). To prevent this, starting with this HotFix, you can use the environment
variable ES_PRODUCTION in the server’s [ES-Environment]. When set to Y, this variable prevents the
IDE from initiating a debug session.

2825848 (1100160)
• When running with HSF switched on, it was possible to have a concurrent shared memory access

which would lead to shared memory corruption. This would most likely occur when running JCL jobs
although it could occur with any tasks. Shared memory access in this scenario is now performed under
a shared memory lock.

2824909 (1099975)
• When using a secure region and when the environment variable

ES_ESM_DISABLE_DFLTUSER_ESMAC is set to Y, clicking on the Home button in the signon page
now correctly opens the MFDS page.

2824772 (1099949)
• When the casspool.dat file is shared across multiple servers (excluding cluster scenarios), ESMAC

displays all jobs, including those that are not running in the current server. However, it is only possible to
cancel jobs that are running in the current server. For other jobs the CANCEL button is disabled.

2824230 (1099917)
• It is now possible to start a BATCH printer in ESMAC if its name consists of space characters only but

an exit name is provided.

2819122 (1099216)
• When using ESMAC, Enterprise Server now correctly loads the MFESMAC resource class, when

necessary. Previously, it was loading the ESMAC class.

2814789 (1098652)
• You can now use the environment variable ES_ESM_DISABLE_DFLTUSER_ESMAC in order to disable

the ESMAC default user. When this variable is set, the "DEFAULT" button on the logon screen is
disabled and a valid userid and password must always be entered.

2813092 (1098438)
• DBCS fields are now processed correctly when the PS attribute is set in the DSECT rather that defined

in the MAP in single field, groups and OCCURs.

2811683 (1098233)
• Web service timeout values are no longer truncated to two digits.

2792860 (1096024)
• An issue with dynamic debugging has been fixed where, previously, the ports that were freed were not

being reallocated.

2785911 (1095510)
• An artificial restriction on the size of cookies passed when invoking ESMAC requests has been

removed. Previously, this was causing Run-Time exceptions.

2692460 (1094557)
• The characteristics of an FCT that references a cataloged file are now refreshed on each file open.
• If a file was already present, the date for an open request was not sent to the file handler.
• Open and close operations are no longer recorded in the transaction logs and replicated by extension

when they are associated with open input requests.
• A secondary node in a group no longer attempts to take over the role of a primary node. The entire

group now initializes correctly and all roles are assigned as expected.
• Microsoft's Internet Explorer versions 10 and 11, by default, does not use the current form name. As a

result, when invoking the javascript functions, the form name was not correct and the product behavior
was wrong. This has now been fixed.

• This release provides a number of enhancements to the CAS administration console:
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• Improvements have been made to the log-in mechanism for situations where you are using an
External Security Manager to secure the MFDS and Enterprise Server, and you are logged on to
MFDS and ESMAC using different user accounts – for example, "user1" and "user2", respectively. If
you navigate from ESMAC to MFDS and you log off "user1" from the MFDS, this will now
automatically log off "user2" from ESMAC as well.

• When using an external security manager, if you sign off from ESMAC, the sign on screen no longer
preserves and displays the userID of the last user that was logged on.

• An issue with the "Home" link in the ESMAC sign on page when the environment variable
ES_ESM_DISABLE_DFLTUSER_ESMAC is set has been resolved.

2814494 (1098607)

• A memory leak occurred in the External Security Facility's MLDAP ESM Module in some HotFix
releases of Enterprise Server 2.2 Update 2.

2833758 (1101024)
• When using the Enterprise Server External Security Facility with the audit feature, some audit events

generated by ESF Admin requests (such as ADDGROUP or ALTGROUP commands specifying many
group members) may include too much information to fit in a single audit event. These parameters are
now split across multiple audit events of category 5, type 3. Each split parameter has a unique number
(per process), and each piece of a split parameter has a sequence number. The original event will
contain a string with the split parameter identifier.

2827010 (1100238)
• The new resource access authorization processing in Enterprise Server's MLDAP ESM Module (LDAP-

based security), introduced in HotFix releases of Enterprise Server 2.2 Update 2, now correctly handles
cases where multiple access control entries have the same rank. For example, this may apply when all
group mode is enabled and an Access Control List (ACL) contains Access Control Entries (ACE) for
different groups the user belongs to.

2826650 (1100313)
• In Enterprise Server 2.2 Update 2 HotFix 06 only, when Enterprise Server External Security is used

with the "Version 2 Authentication" mode enabled, some ACEs might not be processed or applied. This
has been fixed.

2826650 (1100195)
• When using the Enterprise Server External Security Facility (ESF) with auditing enabled, and using the

ESF Admin API (programmatically or with the Enterprise Server Administration web interface or the
esfadmin command-line tool) to make certain changes to security data, very large audit events could be
generated. In some circumstances these could cause the Audit Manager process to crash or hang the
program making the request. This has been corrected by truncating parameter information for very large
security administration requests.

2825505 (1100158)
• When using Enterprise Server External Security Facility (ESF) with the optional Referential Integrity

User Exit, integrity constraints are now ignored for Access Control List (ACL) actors containing wildcard
characters. This enables ESF Admin actions that include resource access control ACLs containing
wildcard actors.

2824117 (1099908)
• The optional ESF Referential Integrity user exit module no longer fails with an LDAP "filter error"

message when processing certain resource-rule commands, such as ALTRESOURCE, for resource
rules with names that include an asterisk, "*".

2824049 (1099884)
• The "referential integrity" sample user exit module for Enterprise Server External Security no longer

causes the MFDS process (Enterprise Server Administration) to terminate when external security with
the exit is configured for MFDS, and MFDS is used to add a user or to perform some other security
administration tasks.

2823947 (1099880)
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• A new MFDS command line startup option (-b) is now available. Specifying -b disables the
establishment of anonymous MLDAP API sessions.

2818587 (1099264)
• This release enables you to prevent an Enterprise Server Monitor and Control (ESMAC) user from

displaying an enterprise server's environment variable settings using the "Env. Vars." button or the direct
URL. To enable this feature, you need to create a new element (ENV*) in the LDAP schema in the
CN=MFESMAC group below CN=Enterprise Server Resources.

This release includes an updated copy of the supplied LDIF import files that contain this change. Once
this element is installed in the security manager, you can control the visibility of the environment
variables page by configuring the group/user access rights using the microfocus-MFDS-Resource-ACE
attribute.

2811696 (1098264)
• The number of security manager user group members displayed by the Enterprise Server

Administration and the esfadmin tool is no longer limited to a maximum of 1024.

2807579 (1097703)
• Trying to use the SNMP audit emitter with Enterprise Server no longer fails with a run-time system error

114.

2800729 (1096951)
• The MLDAP ESM Module, part of the Enterprise Server External Security Facility, now supports

"nested" user groups where one user group can contain another user group. Members of the contained
group belong to both groups. This enables administrators to define very large user groups as well as
hierarchies of user groups.

2510993 (1078988)
• A new option, "LITERAL=YES" has been provided in the Enterprise Server External Security Facility's

Administration API, and in the esfadmin command-line utility. When this is set, "*" is not interpreted as a
wildcard when using any of the administrator's LIST commands. This is particularly useful for listing
resource access rules that include "*" in their name. Search the product documentation for esfadmin for
more information.

• Oracle and OCI XA switch modules leaked memory when using user personalization.

2830922 (1100676)

• When issuing an ENQ change request in a cluster environment, the request to change the lock type
was being sent to the GLM but not processed locally. It is now also being processed locally.

2826218 (1100148)
• During a cluster RECONNECT request, each cluster client sends a list of active locks and the GLM re-

populates the Global ENQ. Since the introduction of the VSAM shared options, the lock may also
contain a tca ptr which is used to store the client's casmgr information. This is required for lock with
persistence server. A pointer set to low-value was sent as part of a GIVELOCK request, but on the GLM
that value was not used. This causes a run-time system error 114 in casgreqt on the RECONNECT/
GIVELOCKS function. This fix allocates the required tca for client casmgr for a RECONNECT request,
sets up the pointer depending on the lock persistence type as well as the clients casmgr PID.

File Handling

Back to the list

• The IMS recovery process is now working as expected; previously, a scan of the transaction log was
incorrectly resetting the integrity flag of the files logged.

2821280 (1099615)
• You now receive an RC16 error message, if a PDSM file is missing from a list of concatenated DD's.

2821187 (1099770)

44 | Resolved Issues



• Indexed files are no longer corrupted when their file size limit is reached.

2817599 (1099359)
• When lock mode is set to 'automatic', with single record locking, the lock from the previous operation is

released at the start of the next file operation; this is to avoid an ABBA deadlock situation occurring.

2816981 (1099052)
• A new file handler configuration file option (STRICTLSEQ) has been added. Only use this option if

instructed to by Support.

2814458 (1099019)
• MFSORT now takes the record length from a previous output file, if its record length is specified, rather

than defaulting to the value in the SORTIN statement.

2808188 (1098243)
• The rollback recovery process is now working as expected.

2802180 (1097066)
• This release provides a new format of the dataset allocation override rules file that supports multiple

conditions.

2783138 (1095007)

• Copying an ESDS file no longer causes an RTS114 error.

2811583 (1098244)
• When a file is closed under Enterprise Server, the file's details are correctly removed from Fileshare.

Previously, some details were not removed.

2810549 (1098111)
• When handling indexed files, the correct .IDX file is now being processed.

2803247 (1097279)
• A return-code (from the call to callrb) and the file-status is now returned when using JCL to add an

alternate index to a file.

2800520 (1096852)

• During a SORT operation, the DYNALLOC parameter is now parsed, but ignored.

2818757 (1099320)
• A Run-Time System error 114 could occur when passing the sort control card continued onto the next

line.

2818291 (1099152)
• The formatting of COUNT to BINARY (BI) is now supported in MFSORT.

2811581 (1098245)
• A SOC4 error no longer occurs when running a SORT operation containing a large number of

conditions.

2803518 (1099559)
• ICETOOL no longer abends when SORTIN is directed to DUMMY and a physical file is missing.

2790053 (1095812)

HCO for Microsoft SQL Server

Back to the list

• The DISCARDDN option is now enabled.

(608200)
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IBM Language Environment for OS/390 and VM Support

Back to the list

• The Language Environment utilities are now available as Java managed code.

2826067 (1100134)
• Mainframe Language Environment support (LE Services) is now available in Micro Focus Visual

COBOL and COBOL Server.

2799388 (1097806)
• The Language Environment functions CEEGMT, CEEUTC and CEELOCT now return the number of

seconds to millisecond precision.

2796098 (1098276)
• The I-S-Info field of the Language Environment (LE) Feed-Back group has been changed from a pointer

to a PIC S9(9) BINARY item.

IMS Support

Back to the list

• The DLI Interface Block (DIB) was invalid after a path retrieval call from an EBCDIC EXEC DLI
application.

2818159 (1099146)
• Following an IMS Database Control warm restart, IMS failed to return a 'DX' status code on delete of a

logical parent.

2812447 (1098364)
• An IMS database that uses a system generated /SX field to make its secondary index unique was

limited to 4GB in size. This was due to a 4-byte RBA used to construct an /SX field. A new DBD
generation directive, SXRBAFORMAT, allows for control of system generated /SX fields. For details, see
the SXRBAFORMAT topic in your online help. In addition, DBD generation now supports
KEYCOMPRESSION and DATACOMPRESSION directives.

2807747 (1097733)
• A new feature, the IMSLOCK DD statement, has been added as an alternative to the LOCALDLI feature

set by the ES_IMS_LOCALDLI environment variable. To use this new feature, omit the
ES_IMS_LOCALDLI environment variable, and add the IMSLOCK DD statement to job steps that
require LOCALDLI behavior as follows: //IMSLOCK DD * (locking-parm) /* Where (locking-parm) is one
of: EXCLUSIVE – Batch only. Equivalent to LOCALDLI. Requires exclusive. Access to DB – Does not
allow GO sharing. Highest performance batch. SHAREDGO – Batch only. Shared Get Only (dirty read).
Default.

2803155 (1097200)
• Documentation for the MFDBUJCL utility has been updated to include syntax and an example for

executing the Rebuild utility from JCL.

2579603 (1084678)
• When using IMSLOCK EXCLUSIVE (LOCALDLI) feature, an incorrect DB position could result when a

GET-NEXT call follows a PCB switch where a second PCB accessed the same IMS database.

(613461)
• When using the IMS database editor, a database open error sometimes resulted in process termination.

(607437)

• When a PFKEY executes an IMS /FOR command, the screen will be cleared prior to being formatted.

2825736 (1100207)
• Leading null input segments no longer cause incorrect behavior of a transaction.

2817693 (1099329)
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• An EXEC DLI program that specified a symbolic checkpoint (SYMCHKP) call but did not include any
AREAs failed to compile.

(612244)
• The presence of superfluous parentheses in the EXEC DLI PCB keyword caused errors. These

parentheses are now ignored.

(612721)

• Connections by the same user from more than one terminal caused incorrect behavior.

2824846 (1100164)
• The /DISPLAY USER command sometimes failed to recognize valid usernames.

2817244 (1098959)
• IMS applications using 3270 datastream optimization erroneously changed values in the screen buffer.

2814267 (1098667)
• An IMS ACB error no longer causes a Run-Time System error RTS200.

2809817 (1098004)
• MQ-IMS Bridge messages with little-endian encoding are now supported.

2803805 (1097573)
• The /DIS USER command did not remove messages from the message queue. The /DEQUEUE USER

command is now available to remove messages from the message queue.

2781608 (1095370)

JCL Support

Back to the list

• This release provides a number of enhancements to the ESMAC spool view:

• Specifying a large page number and clicking "<" (previous page) displays the current page. Similarly,
typing a large page number and pressing ">" (next page) opens the last page if the page number you
specified does not exist. Previously, the product abended with an RTS 114 in both scenarios.

• The total number of pages has been removed from the ESMAC spool view in order to improve the
display performance of this page. - A new button, "go", enables you to navigate to a specified page.
If you specify a page number that does not exist, this opens the last page.

• If you are viewing the last page, clicking ">" (next page) opens the first page. Clicking "<" (previous
page) when the spool view shows the first page, will redisplay the first page.

2829135 (1100722)
• Security check for user access to CANCEL.* resource is now made only if the queried job is in the

ACTIVE queue. Previously it was being made for jobs in all queues. This was not necessary as jobs on
queues other than the ACTIVE queue CANNOT be cancelled.

2828492 (1100393)
• Previously, on the JES spool screen in ESMAC, if an automatic refresh was set up, the screen would

revert to displaying the contents of the Output queue after a refresh even if the radio button for another
queue was selected and showing as enabled on the screen.

2785064 (1095144)

• Within ESMAC, jobs in INPUT queues are now deleted correctly.

2828372 (1100382)
• Under mainframe emulation, opening a virgin file I-O now correctly returns a 3/5 status.

2827755 (1100327)
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• JCL validation has changed to allow parentheses when assigning a symbolic parm on a PROC
statement without enclosing the string in quotes; for example, the following is now allowed: //PROCBAD
PROC DISP=(,CATLG)

2824260 (1099915)
• Submitting an empty file to the JCL internal reader no longer causes an error.

2813939 (1098593)
• JCL PARM statements containing symbolics that are split over multiple lines are now passed correctly.

2811692 (1098262)
• The environment variable MF_SPOOL_ARCHIVE_LOC, which sets the location for the contents of the

MVS SPOOL spool file to be copied prior to deletion, can now be set to a value with or without a trailing
slash.

2811289 (1098730)
• A syntax error in the SET statement no longer causes ESMAC to hang.

2809821 (1098106)
• A problem with the CTF tracing of mvscatio during region shutdown, which caused exceptional

termination of processes, has been corrected.

2809071 (1098043)
• Data sets with a normal disposition of PASS and an abnormal disposition of CATLG are no longer

removed incorrectly.

2790099 (1095773)
• An error in the allocated data set information returned by MFJCTLBP has been corrected.

2788775 (1095585)
• Spool datasets with the same DD name, which are created in the same job but from different steps with

the same step name, will now be archived as expected, and will create unique entries in the archive
index file.

2786077 (1095243)
• When DSNALI is called with the function parameter DISCONNECT, it will also close the connection.

2780333 (604544)
• The file status is now correctly displayed as "9/009" when the JES "Default Allocated Dataset Location"

setting is set to a directory that does not exist.

2693298 (1093619)
• A problem with the MVSP0027 spool archive process, which was causing spool records to be removed

without archiving them, has been corrected.

2677631 (1092956)

• Previously, the allocation override processing produced an uppercase path for the first rule in the file.

2836531 (1101338)
• SSTM jobs are now displayed correctly in ESMAC in the JES > SPOOL > ACTIVE list.

2813588 (1098501)
• You no longer receive a memory error in the catalog program produced when using Fileshare to access

VSAM files with large record sizes.

2807110 (1097830)
• To decrease the amount of memory used when processing CICS spool datasets in an SSTM region,

you can now use a new environment variable, ES_JES_FREE_SSTM_SYSOUT, and set it to "Y".

2660637 (1091980)
• The MFELXA file is now removed when the spool housekeeping is executed and the spool files are in a

non-default location.
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2659555 (1097267)
• The rules file used for overriding the location for creating datasets has a new format that enables you to

use specific names, define conditions on them and to define multiple conditions. See your product help
and the sample "JCL - Allocation Override" in the Mainframe Samples for more details. The older file
format is still supported so there is no need to change any existing configuration files.

(601709)

• Trying to open an input of an empty ESDS file now correctly results a 3/5 error.

2824959 (1100323)
• Using the LISTCAT LVL command under IKJEFT01 now returns a condition code of 4 for empty GDG

base entries. When using PROF NOPREFIX, LISTCAT LVL lists the GDG base and the step ends with
COND CODE of 0.

2796751 (1096433)

• The use of a PATH entry in VSAM Shareoptions, which previously resulted in an error, has now been
corrected.

2827366 (1100286)
• When asking for file information for an input file to a JCL SORT step, an 'access denied' error is no

longer produced.

2824933 (1100014)
• An error when running an ICETOOL statement, where multiple steps were causing a file locked error to

be returned due to the files not being closed at end of step, has been fixed.

2822169 (1099656)
• The incorrect removal at the end of a job, of a cataloged PASS'd data set, has been corrected.

2822144 (1099644)
• IEBGENER now pads LSEQ files with spaces rather than with low values.

2813760 (1098521)
• When concatenating SYSUT1 data sets, the validation of logical record lengths is now working as

expected.

2810787 (1098246)
• Mainframe SORT emulation now adheres to the rules of the environment variable

MFJ_INPUTDS_ERROR.

2803524 (1097176)
• A MVSCATPB call to functions DLET, REN, or REPL, with a DSNAME of nulls no longer causes the

catalog to become corrupt.

2793169 (1096127)
• If a concatenated data set has an LRECL of zero, then the LRECL value of the previous file in the

concatenation is used.

2660492 (1090627)
• IEBDG has been corrected to process an empty input file with a return code of 0.

2607628 (1088100)
• When MF_DEL_DYNPDS=Y, deleting the entire dynamic PDS now deletes all members and also the

directory folder.

2567645 (1088706)
• A problem that produced an RTS 114 error when tracing the IDAEFT01 module has been corrected.

(607893)

• REPRO for ALTERNATE INDEXES and PATHS is treated as a "NO-OP", because it is not appropriate
for the underlying physical structure of the Micro Focus files.
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2800292 (1096872)
• A new option when performing IDCAMS REPRO allows the bypass of the pristine file state (Error

JCLAM0150S) and the REPRO to produce an empty output file: set the environment variable
MFJ_REPRO_EMPTY=Y.

2790606 (1095968)
• A problem causing the truncation of a catalog listing to 100 VSAM clusters has been corrected.

2654125 (1090116)
• IDCAMS now processes the TSO ALLOCATE(xxx) COPY(yyy) command correctly, where the yyy data

set is a VSAM data set.

2581587 (1096352)

• The ON condition processing has been changed in order to avoid generating "IF <conditon> GOTO"
label statements before every EXEC statement.

2787049 (1095670)

Library

Back to the list

• Using a dd_ environment variable to specify the path used in CBL_LOCTE_FILE now works as
expected.

2822153 (1099632)

Mainframe Access

Back to the list

• A new parameter, /ENDLOG=<endlogPath>, has been added to the MFDAS Endevor commands. If an
endlogpath is specified and the Endevor command fails, the transaction log is downloaded to the
specified location.

2814266 (1098581)
• The FS_CHECK_FILE_EXIST routine no longer deletes the data set being checked on a mainframe.

(608326)

• MFMONMX.exe now returns a non-zero return code when it encounters an error.

2814298 (1098677)
• If the "Delete workstation file if mainframe member is deleted" option in the advanced synchronization

options of Mfmonmx2 is checked, mfmonmx2 now successfully executes the operation. Deleting an
entire directory on the mainframe is also synchronized.

• An occasional abend U0996, which occurs when the MFA Endevor job starts, should no longer occur.

2828402 (1100415)
• You no longer receive an error message "Unknown return code 9/64" when importing copybook

members in Source Connect.

2809371 (1097999)
• The MFDAS EXPORT PAN commands now work correctly.

2805251 (1097867)
• MFA server now supports CA Endevor R17.

2800686 (1096931)

Micro Focus Common Client

Back to the list
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• The Micro Focus Common Client, used by COBOL Web Service proxies and other components, now
allows HTTP URLs with certain characters such as ":". It also no longer rejects correct URLs with "%xx"
escape sequences.

2828629 (1100520)

Micro Focus Communications Server

Back to the list

• An issue with leaked sessions for IMS Connect conversations has been corrected.

2797552 (611154)
• Certain Enterprise Server administration actions such as notifying a running enterprise server of a

security update could cause MFCS to hang.

2784219 (1095045)

Micro Focus Directory Server

Back to the list

• The generated HTML fragment displayed for an individual resource entity element when using the
Enterprise Server Administration HTML GUI to administer an external Security Manager was
overflowing a fixed size buffer. This is now allocated based on the actual length required.

2828732 (1100545)
• Corrected the resource entity that the Enterprise Server Administration GUI checks to determine

whether the external Security Manager administration pages are accessible to a logged on user. The
correct resource entity is "User Administration" under the "Enterprise Server Administration" resource
class.

2828553 (1100539)
• Require read permission before returning repository data for authenticated users if MFDS is started with

the -b option.

2828228 (1100364)
• Access to password data is prevented on the security manager edit page in the Enterprise Server

Administration HTML GUI.

2827942 (1100333)
• When MFDS is secured using an external Security Manager, it does not display internal security

configuration pages which no longer have an effect.

2827786 (1100314)
• Correct display of user session data in the Enterprise Server Administration HTML GUI.

2826210 (1100161)
• An issue with the persistency of the audit output option in the MF Directory Server security configuration

has been resolved.

2824201 (1099902)
• Honor the trace flags values set in an Enterprise Server XML configuration file when importing it into

MFDS via the -g command line option.

2823855 (1099846)
• An issue with storing certificate passphrase in the Enterprise Server Administration HTML GUI form

data has been resolved.

2820846 (1099448)
• The resistance of the Enterprise Server Administration HTML GUI log-on page to cross-site scripting

attacks has been increased.

2819223 (1099212)
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• Improve browser caching control to increase security of the Enterprise Server Administration HTML
GUI.

2819218 (1099209)
• An issue with storing certificate passphrase in the Enterprise Server Administration GUI has been

resolved.

2819212 (1099207)
• The Enterprise Server Administration web page makes additional authorization checks before

displaying screens.

2819069 (1099192)
• The Enterprise Server Administration web page no longer displays sensitive session data.

2818974 (1099178)
• Password length restriction has been fixed in the Enterprise Server Administration login page.

2818973 (1099179)
• Enterprise Server Historical Statistics Facility (HSF) configuration can now be exported and imported

via the mfds -x and -g command-line options.

2815030 (1098695)
• Previously, the Enterprise Server Administration journal export to text truncated the exported file.

2802793 (1097108)
• It is now possible to expand and collapse items within the tree view of the external security manager

security resources in Enterprise Server Administration.

2801421 (1096979)
• The MFDS GUI now correctly displays external Security Manager resource ACL strings that are greater

than 3K byte length.

2800727 (1096978)
• The MFDS -x XML export option was not exporting Windows Monitoring and Management configuration

values for enterprise server instances.

2794382 (1096428)

Micro Focus Server Administrator (GUI)

Back to the list

• If access to Enterprise Server Administration is restricted by use of an MLDAP ESM-based external
Security Manager, you can now configure a user to have access to the "Security" menu item but not to
the "Options" menu item.

2804728 (1097916)
• Previously, when expanding or collapsing items in the tree view for external Security Manager within

Enterprise Server Administration, items associated with a user or a group no longer would always move
to the top of the resource list.

2803399 (1097848)
• If MFDS is configured to use an external Security Manager with the Windows "user" class, it is not

possible to edit the users from the MFDS GUI and you receive a warning.

MLDAP API Interface

Back to the list

• The MLDAP ESM module now recognizes a wider range of errors that indicate that the specified LDAP
server is unavailable and, if configured, the server will retry to establish a connection.

2799921 (1098128)
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• The MFDS GUI and the ESFADMIN utility now display the pages with LDAP query results.

2681539 (1092705)

Monitoring and Management

Back to the list

• The HSF records for JCL STEPs could contain incorrect values for IMS, SQL and API fields because
they were not initialized for each STEP. This has been fixed.

2830910 (1100672)

PL/I Support

Back to the list

• Specifying -optexec plitest for a program that uses more than one EXEC language (such as SQL, CICS
and DLI) now works as expected and generates or activates only one instance of the CodeWatch
debugger.

2783575 (1094972)
• The CICSDEMO Open PL/I sample application has been updated to provide a demonstration of both

32-bit (X86) and 64-bit (X64) projects and execution environments.

(609689)

• The ROUND built-in function now works with FIXED BINARY data.

2830667 (1100641)
• A problem with initial repetition factors not working for the GRAPHIC and WIDECHAR data types has

been fixed.

2830665 (1100640)
• A problem with the RANDOM built-in function has been fixed.

2830364 (1100611)
• A problem with ALLOCATE CTL EXTERNAL has been fixed.

2828211 (1100361)
• A problem with the DECIMAL built-in function when the second and third arguments (precision and

scale) are both omitted has been fixed.

2827872 (1100326)
• A problem when the second and/or third arguments of the SUBSTR built-in are expressions of result

type fixed bin (31) has been fixed.

2825937 (1100124)
• A problem with automatic initializers containing function calls with star-extent parameters has been

fixed.

2825936 (1100123)
• Previously if linking a shared object on Linux utilizing the -dll, -so, -mvs, -ims or -cics flags you would not

be notified if there were any unresolved external symbols (default behavior of the ld linker). You will now
receive a warning from the linker for any missing unresolved external symbols.

2822736 (1099722)
• A new compilation option, -rc, enables you to set the minimum error code level 0, 4, 8 which results in a

zero return (successful compilation).

2822734 (1099721)
• A problem with multiple allocate statements of a based variable with initializers resulting in the compiler

warning MFPLI00121W ("fewer values than are required to initialize the variable") has been fixed.

2821140 (1099524)
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• A problem has been fixed with the ALLOCATE statement where CONTROLLED items with variable-
sized extents are evaluated at the execution of the ALLOCATE statement.

2818212 (1099406)
• Previously, if a user program was compiled with -range and using the VERIFY() builtin function on a

zero length string with an omitted starting position argument, STRINGRANGE was incorrectly raised.
This has now been fixed.

2815832 (1098780)
• A problem with the REPEAT and COPY built-in functions when the repeat string is of constant length >

1 has been fixed.

2813416 (1098487)
• A problem when appending diagnostic messages to listing file resulting in a compiler I/O abort has been

corrected.

2806933 (1097641)
• The PL/I compiler no longer crashes for some cases where a function returning a CHAR VARYING

value is used as an argument.

2802889 (1097127)
• The NONASSIGNABLE attribute is now diagnosed as not yet supported.

2800777 (1096900)
• String truncation is now diagnosed when the target string is shorter than the source string in an

assignment statement or INITIAL clause.

2800745 (1096898)
• A function without a return statement is now diagnosed.

2799526 (1096718)
• DEFAULT RANGE storage and alignment attributes are no longer applied to named constants.

2795076 (1096300)
• A problem causing error 2000A when using the construct: TRIM(STRUCTURE), BY NAME ; has been

fixed.

2788933 (1095606)
• A problem with ALLOCATE in an AREA variable based on a pointer returned by a function invocation

has been fixed.

2787752 (1095450)
• The Open-PL/I compiler now supports the %INCLUDE statement syntax: %include

LIBRARYNAME(FILENAME); If LIBRARYNAME is used, it is ignored. The above statement is
equivalent to: %include FILENAME; and the rules used for the compiler options -ipath and -isuffix are
applied.

2691090 (1093644)
• A problem causing Error MFPLI00109S when passing a controlled structure containing arrays as an

argument has been fixed.

2680705 (1092894)
• The compiler option -zalign has been added for Z/OS structure mapping behavior. This feature is in

Early Adopter Product (EAP) release status.

2675882 (1092102)
• Problems with the order of block prologue initialization of automatic variables have been fixed.

2675382 (1092043)
• -fdmaxp available in ED 2.2 U2 now provides the requested arithmetic precision functionality.

2614820 (1088014)
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• The compiler now diagnoses BASED variable declarations which contain both REFER-extents and
other extents with non-constant values.

(610382)
• The CONNECTED and NONCONNECTED attributes are now accepted on the DEFAULT statement.

(607463)

• If a hex literal was embedded in a non Macro IF/THEN, where the "THEN" invoked a macro procedure
to generate its source, the "X" that terminated the hex literal was split across a %SDEBUG; which
caused the source to no longer compile. This no longer happens.

2802841 (1097112)
• Previously if utilizing a FIXED variable in a preprocessor macro in an expression without a comparison

operator such as =, <, > in an IF statement with the bitwise OR ("|"), an incorrect result was returned.
For example: %IF PLI_64BIT | SYSOS = "WIN" THEN The behavior was also exhibited if a similar
expression was used as an assignment into a macro preprocessor variable. This has now been fixed.

(610534)

• Previously, a warning message occurred about sprintf used in systemcics.o when linking a PL/I CICS
application with the most strict unresolved external warnings enabled. This no longer occurs.

2831590 (1100755)
• Previously, on Linux and UNIX, if two DD's were of type DUMMY and opened for output, a 9/065 error

occurs and the job abends with a U4038 abend. This no longer happens.

2829194 (1100515)
• Previously a SYSPRINT output via stream I/O in an EBCDIC ES Region with a program compiled with -

EBCDIC resulted in an ASCII output to the EBCDIC file.

2828418 (1100384)
• A fix for RPI 1092067 caused a regression in the processing of input datasets assigned to a DUMMY

DD via JCL.

2813471 (1098494)
• A previous enhancement made to provide support for DD DUMMY without any DCB specified in the

user program or in the JCL broke the behavior when a fixed length file was created using JCL that
contained no DCB information about the DD statement. This has now been fixed.

2804948 (1097350)
• Previously, if you compiled your code with -range and used the INDEX built-in function without the

optional third parameter and a string with zero length, it would incorrectly raise the STRINGRANGE
condition. This no longer happens.

2804815 (1097359)
• The user can use an environment variable of the form DCB_ddname, where ddname equates to the

PL/I file variable name, to specify the record length and format of the file. See the PL/I User's guide for
more information.

2588122 (1085972)
• When using the DELAY() built-in function, and executing such that the output displayed via an

XWindows Server, XWindows sometimes interrupted the process via a signal, preventing the delay
period from fully elapsing.

(611125)

• EXEC SQL (or EXEC DLI or EXEC CICS) statements may now span across multiple include members
and may start anywhere (including primary source file) and end anywhere (including primary source
file). Such statements can also be debugged using the debugger successfully and correctly.

2824293 (1099907)
• GRAPHIC and WIDECHAR data types are now supported in PL/I SQL.
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2809520 (1097905)
• The DB2 pre-compiler no longer requires setting the DB2(UDB-VERSION) directive when compiling

against DB2 z/OS server.

2799215 (1096688)
• Previously, when two consecutive EXEC SQL INCLUDE statements were made with no intervening

logic and when each one of these statements started and terminated with a larger comment, an error
occurred in the tokenizing phase. As a result, any EXEC SQL logic contained in the second INCLUDE
was missed and not preprocessed.

2797042 (1096728)
• SQL embedded within PL/I macro code included via EXEC SQL INCLUDE is now supported.

2605681 (1087117)

Run-Time System

Back to the list

• A run unit created with the RuntimeServices RunUnit class no longer causes an exception to occur if no
COBOL code has been executed inside it before the RunUnit is terminated with a StopRun() method.

2826239 (1100198)
• You now receive a correct error code when the product does not find a file located on a network drive.

2822161 (1099619)

• The RM/COBOL version of the “SYSTEM” library routine nows supports the return of an exit-code, for
native COBOL applications.

2830238 (1100599)
• When using ADIS DISPLAY statements and the RELDECDELIM=0D0A file handler configuration option

on UNIX, you could receive a Run-Time System error during process termination.

2829860 (1100601)
• On UNIX platforms, if the Audit Manager process is recycled, dependent processes will continue to

pass events to it after it's recycled; previously, these processes would hang.

2810770 (1098085)
• On a 32-bit Enterprise Server running on Windows, tasks that are blocked in the operating system can

now be canceled without terminating the SEP process.

2807997 (1097918)
• An error in generated code when initializing comp-2 data items from fractional literal values has been

fixed.

2800938 (1096960)
• The tunables default_cancel_mode and subsystem_cancel_mode both have a new setting, which

enables programs to remain in memory after they are canceled; this is opposed to the default behavior,
which physically removes .dll files and shared objects from memory when they are canceled.

2690881 (1096628)

Setup

Back to the list

• A problem with the product setup file handling install locations has been fixed.

2802386 (1097065)

SQL: COBSQL

Back to the list
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• The COBSQL preprocessor generated an error when it encountered a host variable declared as "01 HV
PICTURE S9(9) VALUE ZERO COMP."

2826093 (1100163)
• COBSQL now honors the position of the $SET statements in copybooks that are expanded inline in the

editor by the CP preprocessor.

2825364 (1100308)
• COBSQL examined hostvars in commented lines, causing compilation errors.

2824211 (1099928)
• CCOBSQL now processes COPY... REPLACING COBOL data items' level correctly.

2813839 (1098531)
• The COBSQL preprocessor inserted a NULL character in front of each non-printable character, causing

errors when processing Pro*COBOL (i.e., when COBSQLTYPE=ORACLE8).

2809551 (1097939)
• COBSQL did not always correctly handle COPY... REPLACING with text exceeding the 72 column.

2809404 (1097890)
• COBSQL incorrectly handled COPY... REPLACING when the level numbers of data items in the

copybook were being replaced.

2807898 (1097765)
• COBSQL was not recognizing the DECLARATIVES statement in some scenarios.

2804183 (1097346)
• COBSQL now processes COPY...REPLACING statements correctly.

2779818 (1094538)

SQL: DB2 ECM

Back to the list

• The HCO DCLGEN tool sometimes generated inappropriate values for REAL and DOUBLE columns in
PL/I copybooks.

2831022 (1100684)
• The DB2 ECM incorrectly generated code to process SET CURRENT PACKAGE PATH, resulting in

SQLCODE -4952 when executed.

2817342 (1098963)
• HCO incorrectly handled .bnd files. The new DB2(BINDDIR) directive resolves this issue.

2815734 (1098893)
• The DB2 ECM preprocessor incorrectly generated COBDB0103S errors when a fixed CHAR host

variable was defined as greater than 254 characters.

2803193 (1097169)
• When FILLER was used in group host variable structure, the DB2 ECM raised an SQL4914 error.

2802547 (1097091)

SQL: HCO for SQL Server

Back to the list

• The OpenESQL pre-compiler no longer incorrectly swaps a colon and blank inside a literal if compiled
with HCOSS directive SQL(DIALECT=MAINFRAME), which was resulting in a -305 SQL error when
executed.

2822809 (1099757)
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• The OpenESQL preprocessor generated incorrect connection information when compiling with the
SQL(INIT) AND CHARSET(EBCDIC) directives.

2814325 (1098596)
• The OpenESQL preprocessor sometimes erroneously returned SQLCODE error code 1, NULL value

returned but no indicator variable supplied, when it encountered a stored procedure call.
• DLL files for 64-bit aliases for DSNTEP2 and DSNUTILB were not available, and have been added in

this release: 64-bit DSNTEP2 alias DLL: sqltp264.dll 64-bit DSNUTILB alias DLL: sqlutb64.dll. Use
these in JES alias-program mappings.

SQL: OpenESQL

Back to the list

• When compiling for ODBC, the OpenESQL preprocessor failed to generate correct SQL code for some
large SQL statements.

2832617 (1100892)
• When compiling a WCF Service application with the SQL(DBMAN=ADO) directive, the OpenESQL

preprocessor attempted to generate SQL interface code, resulting in a COBCH002 error.

2827979 (1100367)
• The GetHire stored procedure sample showed that a COBOL CLR stored procedure could cause an

exception to be thrown when using stored procedure definition files, and when compiled without
SQL(DIALECT=MAINFRAME).

2827854 (1100318)
• Run-time exceptions sometimes resulted from dynamic COBOL calls in stored procedures.

2819325 (1099263)
• The OpenESQL runtime sometimes generated an index out of range error on SQL statements in

managed applications when the PID generated by the OpenESQL preprocessor for each method was
not unique.

2815075 (1098749)
• A problem where a stored procedure that uses DIALECT=MAINFRAME could throw an exception if the

HCOSS stored procedure remapping table had not been deployed to the database has been fixed.

2809927 (1097972)
• The OpenESQL preprocessor did not support SELECT statements coded with a colon (:) on host

variables after the INTO clause for ORACLE PROCOB migration applications.

2596427 (1086198)
• The OpenESQL preprocessor has been enhanced to allow the use of PIC S9(5) COMP-5 host variables

for INTEGER data on programs migrated from Pro*COBOL.

2596426 (1086197)
• When using SQL(DATE=EXTERNAL) with Oracle, timestamp values were formatted incorrectly. This

has been change to correctly format timestamp values according to the setting of
NLS_TIMESTAMP_FORMAT.

2596425 (1086196)
• When SQL(PROCOB) is set, Oracle date and timestamp result types fetched into PIC X(n) host

variables are truncated without warning.

2596424 (1086195)
• An SQLCODE incompatibility existed between Pro*COBOL and OpenESQL ADO.NET. This has been

corrected. Setting SQL(PROCOB) now also sets SQL(CHECKSINGLETON). When SQL(PROCOB) is
set, OpenESQL error codes in the SQLCA are converted to Pro*COBOL-compatible error codes, which
are controlled by a new file, mfpcocds.txt. This file is delivered in %ProgramData%\Micro Focus
\SQLCODES by default.
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2595728 (1087599)
• The OpenESQL runtime for ADO.NET returned times using a 12-hour clock. It now returns times using

a 24-hour clock.

• For managed-code projects, PF_RO_CURSOR and other BEHAVIOR primitive directives were not
available from the User Interface.

2833926 (1101049)
• Some problems related to using ASSOCIATE with the Host Compatibility Option for SQL Server where

the stored procedure name was supplied in a host variable have been fixed.

2831480 (1100747)
• HCO with SQL Server (HCOSS) using the ADO.NET run-time system exhibited a problem retrieving

result set locators on the second call and subsequent calls to a stored procedure.

2830688 (1100659)
• The SQL CLR wrapper program generated by the Generate SPD File tool caused errors during

deployment when it contained one or more data types exceeding 8000 bytes in size. To eliminate these
errors, the Generate SPD File tool now generates the SQL CLR wrapper program with MAX SIZE = -1.

2830545 (1100650)
• PIC X host variables passed to the server as variable-length data with trailing blank suppression

sometimes caused OpenESQL to return different query results than some earlier versions of this
COBOL development product.

2829810 (1100685)
• When generating a COBOL wrapper program, the Generate SPD File tool did not support the passing

of all parameters for a SQL CLR Stored Procedure definition routine as fixed length. To resolve this, a
new option, GENFIXEDLENGTH, has been added.

2829499 (1100629)
• A number of issues with PostgreSQL record logic and error handling have been fixed in OpenESQL's

run-time systems for ODBC and ADO.NET.

2828058 (1100338)
• When the SQL(PROCOB) directive is set, OpenESQL for ADO.NET now supports anonymous PL/SQL

blocks and the following host variable types: SQL-CURSOR SQL-ROWID SQL-BFILE SQL-BLOB SQL-
CLOB SQL-NCLOB

2825199 (1100003)
• When compiling with the SQL(PROCOB) directive, the OpenESQL preprocessor sometimes generated

incorrect SQL code when a host variable reference in COBOL was split over multiple lines.

2825194 (1099997)
• When using the SQL(CHECK) directives with SQL TYPE CLOB host variables, compilation sometimes

failed.

2819480 (1099342)
• Windows GUI projects compiled with the SQL compiler directive might throw a

MicroFocus.COBOL.Program.COBOLStopRunException on GOBACK.

2816463 (1098907)
• The insertion of more that 8000 characters into a SQL Server VARCHAR(MAX) column from a PIC X(n)

host variable caused a data truncation error.

2814679 (1098675)
• When SQL(TARGETDB=ORACLE) was set and the FOR UPDATE clause was used to enable row

locking, this combination could sometimes trigger a runtime failure. SQL(TARGETDB=ORACLE) is no
longer required to enable row locking via FOR UPDATE clauses on queries.

2814613 (1098624)
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• A 114 error on DISCONNECT sometimes occured due to a long-standing bug in Oracle ODBC drivers.
This release provides a workaround. The ODBC specification states that the ODBC row status array is
an array of 2-byte integers, but some Oracle ODBC drivers from Oracle 11 onwards have been
observed to use either 4-byte or 8-byte integers. The OpenESQL runtime for ODBC now automatically
detects the element size used by the driver when an Oracle connection is opened, and adapts its
behavior accordingly.

2813428 (1098480)
• OpenESQL now supports OUTPUT clauses in SQL Server INSERT, UPDATE, and DELETE

statements. HCO for SQL Server now supports the DATA-CHANGE-TABLE-REFERENCE clause.

2812940 (1098424)
• An SQLCA error message occurred when inserting a record into a table using a SQL CLR stored

procedure with a VARCHAR (max) column where the host variable was more than 8000 bytes.

2812261 (1098390)
• The OpenESQL preprocessor incorrectly generated a COBES0100 error when compiling code that

contained GEN-GV-FROM-GROUP and the same host variable used multiple times in same SQL
statement.

2811682 (1098231)
• The OpenESQL preprocessor reported an error for LOCK TABLE statements encountered when using

an Oracle database with the SQL(CHECK) compiler directive option.

2808579 (1097797)
• When using the SQL compiler directive option to compile a program that contained no SQL statements,

a 153 trap occurred when the OpenESQL preprocessor encountered SQLCODE defined as COMP.

2808076 (1097758)
• The OpenESQL preprocessor sometimes generated a "COBCH0302 IF....ELSE or scope-delimiter

mismatch" error if a program defined SQLCODE separately as COMP.

2807937 (1097702)
• The OpenESQL preprocessor sometimes generated a STOP RUN rather than a GOBACK at the

program end, which sometime caused improper termination for subroutines not coded with one or more
GOBACK statements.

2807272 (1097624)
• The OpenESQL preprocessor produced a COBES0125 or COBES0112 error message when it

encountered indicator variable arrays used with non-host array variables.

2805207 (1097457)
• COBOL SQL CLR stored procedures can now open connections to other databases using EXEC SQL

CONNECT statements. For type 6 CONNECT statements, this requires using a post-deployment script
to alter the connection string for the OpenESQL runtime such that it runs with EXTERNAL_ACCESS
privilege. For other CONNECT statement formats, INSAFE privilege is required. Use SQL Server
authentication rather than Windows authentication for external connections.

2804010 (1097230)
• In some situations, the OpenESQL pre-compiler incorrectly generated a COBES0125 error, "<variable>

should be defined with an OCCURS clause".

2802029 (1097036)
• The ODBC ECM incorrectly generated swap logic for COMP fields on singleton SELECTs in managed

applications which could result in field corruption if the variable was used in a WHERE clause.

2801806 (1097049)
• The OpenESQL Assistant generated copybooks using the same size for DATETIME2 columns

regardless of their definitions. The OpenESQL Assistant now generates PIC X(26) for DATETIME2(6),
and PIC X(29) for all other DATETIME2 definitions.

2799778 (1096776)
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• A problem that affected the use of 'select *' in OpenESQL subqueries has been fixed.

2799720 (1096751)
• A problem with array fetches into PIC N NATIONAL host variables has been fixed in the ODBC run-time

system for OpenESQL.

2799002 (1096790)
• The OCI run-time now handles the NULL indicator correctly when running in 64-bit mode.

2792566 (1096149)
• OpenESQL for JDBC now supports positioned updates with PosgreSQL.
• The THREAD SQL compiler directive option mishandled threads in certain scenarios.
• In certain scenarios, OpenESQL incorrectly handled host variables defined as SQL TYPE DBCLOB

when inserting or fetching DBCS data.
• OpenESQL for JVM now supports spaces between the start of an ODBC, JDBC, date, time or

timestamp escape marker and its associated date, time or timestamp literal string when the
SQL(DETECTDATE) directive is set.

• Use of the tinyint (pic s99 comp-5) host variable sometimes resulted in bad code generation for some
OpenESQL runtime systems. Tinyint is now fully supported on all OpenESQL runtime systems.

• The OpenESQL run-time now truncates DBCS character strings cleanly at a whole character boundary.
• Using CHARSET(EBCDIC) in a DBCS locale caused problems with the OpenESQL runtime systems for

ADO and JDBC. This has been corrected by changing the behavior to be consistent with the ODBC
runtime. In particular, SO/SI characters are now correctly inserted and removed for EBCDIC and ASCII
data respectively.

• The one-phase ODBC switch module now handles commit and rollback API calls from applications and
uses DSNRLI correctly, together with handling of global temporary tables by HCOSS applications.

XML Extensions

Back to the list

• The XML model file must be accessible to the XML extensions run-time environment. To make the file
accessible, either add it to the system path, or move it to the directory from which the program is run.

2822399 (1099702)

XML Support

Back to the list

• XMLPARSE no longer reports an error if a prefix is not properly declared and no validation is specified.

2823420 (1099786)
• The Compiler no longer errors preprocessed lines containing non-ASCII characters in the indicator

area. Previously, this could cause user programs using the htmlpp preprocessor to fail to compile.

2805067 (1097977)
• The XML I/O run-time used to read the whole document into memory which caused an out-of-memory

error.

2801337 (1096999)
• The namespace prefix in the namespace declaration is now handled correctly when the element itself

does not contain a prefix.

2799691 (1098150)
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Updates and SupportLine
Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• The Product Updates section of the Micro Focus SupportLine Web site, where you can download fixes
and documentation updates.

• The Examples and Utilities section of the Micro Focus SupportLine Web site, including demos and
additional product documentation.

• The Support Resources section of the Micro Focus SupportLine Web site, that includes troubleshooting
guides and information about how to raise an incident.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page, then
click Support.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.

Also, visit:

• The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See http://community.microfocus.com.

• The Micro Focus YouTube channel for videos related to your product - see https://www.youtube.com/
user/MicroFocusIntl.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.

• The name and version number of all products that you think might be causing a problem.
• Your computer make and model.
• Your operating system version number and details of any networking software you are using.
• The amount of memory in your computer.
• The relevant page reference or section in the documentation.
• Your serial number. To find out these numbers, look in the subject line and body of your Electronic

Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.
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On Windows, you can use the Micro Focus SupportLine Support Scan Utility, mfsupportinfoII, to create
either:

• a .log file that contains the details about your environment, Micro Focus SupportLine products, and
settings.

• a .zip archive that includes the same information as the .log file plus some product configuration
files from c:\ProgramData and the product installation log files.

MFSupportInfoII.exe is stored in <install-dir>\bin.

To run mfsupportinfoII:

1. Start a 32-bit Enterprise Developer command prompt.
2. Enter MFSupportinfoII at the command prompt to start the utility.
3. Create a .log file or a .zip archive as follows:

a. To create a .log file, click File > Save.

This prompts to save the .log file, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MM-
SS.log, in the %temp% directory.

b. To create a .zip archive, click Tools > Create Zip Package.

This creates a .zip archive, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MM-
SS.zip, in the %temp% directory.

4. Send the diagnostic information to your Micro Focus SupportLine representative:

The following requires an Internet connection and an Email client:

a. Click Tools > Email Log to SupportLine to open the Email Log dialog box.
b. Fill in the required fields and click Send.

If the machine is not connected to the Internet or if there are no Email clients installed, copy either
the .log file or the .zip archive to a machine that is connected to the Internet. Use your Email client
to email the files to Micro Focus SupportLine at supportline@microfocus.com together with the Support
Incident (SI) number, if available, and any additional details that might be useful to diagnose the issues
that you are experiencing.

On UNIX, you can use the Micro Focus UNIX Support Scan Utility, mfsupport, to create a log file that
contains the details about your environment, product, and settings. The mfsupport script is stored in
$COBDIR/bin.

To run mfsupport:

1. Start a UNIX shell.
2. Set COBDIR to the product with issues.
3. Execute mfsupport from a directory where you have write permissions.

This creates a log file, mfpoll.txt, in that directory.
4. When the script finishes, send the mfpoll.txt file to your Micro Focus SupportLine representative.

Note:

If COBDIR is set to a location that does not contain etc/cobver, the script outputs the contents
of /opt/microfocus/logs/MicroFocusProductRegistry.dat which keeps a list of the
installed Micro Focus products.

If COBDIR is set to a location that does not contain etc/cobver or COBDIR is not set, mfsupport
gives you the option to search your machine for possible product locations. Note that the search can
take some time if you have a large amount of disc storage and files.
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Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.

64 | Updates and SupportLine



Disclaimer
This software is provided "as is" without warranty of any kind. Micro Focus disclaims all warranties, either
express or implied, including the warranties of merchantability and fitness for a particular purpose. In no
event shall Micro Focus or its suppliers be liable for any damages whatsoever including direct, indirect,
incidental, consequential, loss of business profits or special damages, even if Micro Focus or its suppliers
have been advised of the possibility of such damages. Some states do not allow the exclusion or limitation
of liability for consequential or incidental damages so the foregoing limitation may not apply.

Micro Focus is a registered trademark.

Copyright © Micro Focus 1984-2015. All rights reserved.

This product includes software developed by Computing Services at Carnegie Mellon University (http://
www.cmu.edu/computing/)".
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